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1 Introduction to Comodo Antispam
Gateway

Comodo Antispam Gateway (CASG) is an email filtering solution that blocks spam, email-borne viruses and other unwanted mail
from reaching your inbox. This helps free up company bandwidth and saves you the daily hassle of deleting spam mails.
Logging into your CASG user account will allow you to quickly checkirelease quarantined mails and search the log files. Users
can also modify their account settings and change their password from within the interface.

Features and benefits include:
«  Complete Antispam protection for incoming mails
«  Complete Antispam protection for outgoing mails
»  Easyto use and configure
- Easily manage quarantined mails
- Easily manage recipient whitelist

«  Archive incoming mails

coMODO
; . Quarantine: 2 My A t
G Antispam Gateway A L My Accoun

(€2 Incoming

Quarantine © Hep

B Cuarantine

Archive Show message m Delete ﬁ Delete all D Refresh

Report spa )
eport spam ‘ o e |

[[] Subject From To Date (Gill Reason Size fl | Action

Oct29,  spam
[] demo admin 2014 External pattern 110¢

) . john@docteamcasg.c
1y A . spamemail2  <admin@csg.comodo.od.ua> jehn@ 9C 25503 match byte: a
) Outgoing .
= PM (Sanesecurity.Ju
i
[£5] Account management Oct29, spam
[ demo admin ohn@docteamcasa.c 2014 External pattern 110¢ i
spamemail 1  <admin@csg.comodo.od.ua= John@ 9C 55445 match byte:
PM (Sanesecurity.Ju
1 i [1-212] Perpage |15 w

Guide Structure

This guide is intended to take you through the use of Comodo Antispam Gateway and is broken down to the following main
sections. The guide can be navigated using the bookmark links on the left.

«  How to...- Provides explanation on how to use a specific feature.
«  The User Interface - Provides a snapshot of main functional areas of CASG.

»  Logging-in to the User Interface - How to login to the CASG interface.
«  The Dashboard Area - Describes briefly about Quarantine management and Account management.

« Incoming - Detailed explanation on how to manage quarantined mails, archived mails and perform log search of
incoming emails.

- Outgoing - Detailed explanation on how to perform log search of outgoing emails.

«  Account Management - Detailed explanation on how to change login password and add or remove the self-user
to recipient whitelist, managing subscription to periodical quarantine summary reports and configuring language
for messages displayed/sent by CASG.

»  CASG Reports - An Overview — An overview of the periodical Quarantine summary reports generated and sent to
User by CASG.

«  Appendix - CASG Comparison Table

Comodo Antispam Gateway User Guide | © 2015 Comodo Security Solutions Inc. | All rights reserved 3
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Quick Link to Online Help Guide

Various interfaces will display a help button at the top right side of the interface. Clicking on this help button will take you
to the respective help page of CASG online help guide for more detailed explanation.

Access to various interfaces in the application depends on the permission levels set for you by the administrator. Contact your
administrator if you need to access to features that have been blocked for you.

2 How to...Tutorials

The 'How To..." section of the guide contains guidance on using CASG effectively. Click on the links below to go the respective
tutorial page for detailed explanation.

+  How to login to CASG

«  How to get a new password

«  How to manage your quarantined mails

«  How to use filter options in the Quarantined emails interface
«  How to check when an expected email is not received

«  How to retrieve an email which had virus attachment

«  How to subscribe for periodical Quarantine Report Summary
«  How to perform a log search of your incoming emails

»  How to add or remove a user from recipient whitelist

*  How to report spam emails

«  How to perform a log search of your outgoing emails

«  How to manage archived mails

«  How to manage whitelisted senders

«  How to manage blacklisted senders

2.1 How to Login to CASG

Since CASG is a web application, you can login into your account using any Internet browser by entering
https:/lantispamgateway.comodo.com/user/ in the address bar of your browser.

Comodo Antispam Gateway User Guide | © 2015 Comodo Security Solutions Inc. | All rights reserved 4


https://antispamgateway.comodo.com/user/login.zul

Creating Trust Online®

Comodo Antispam Gateway - User Guide COMODO

fc{ coMODOo
.- Antispam Gateway

I

A Email User Interface

Username

|

Password

Forgotten your password?

Login to the interface with the Username and Password that were sent to you via email after adding you as a user in the CASG
account.

In order to ensure safety, CASG will lock the user account if the login attempts fail for more than three attempts due to incorrect
Username or Password. The account will remain locked for 30 minutes and will allow you to login after it on entering the correct
Username and Password. If you want to unlock the account immediately, contact your administrator.

cr coMODO
/' Antispam Gateway

L Email User Interface

Your accountis locked and will be unlocked in 30
minutes.

Username
I

Password

Forgotten your password?

The time period for which the account is to be kept locked after unsuccessful login attempts can be customized by contacting
your Comodo Account Manager.

In case you have forgotten your login password, click the 'Forgot your password' link to generate a new password for accessing
CASG. Click here for more details.

Comodo Antispam Gateway User Guide | © 2015 Comodo Security Solutions Inc. | All rights reserved 5
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2.2 How to Get a New Password

If you have forgotten your password, you can reset it by clicking the 'Forgot your password' link under the login button or by
requesting your administrator to generate a new password for you. If you know your current password but wish to change it for
any reason then login, click "My Profile’ then 'Change Password'. Click here for more details.

To generate a new password from CASG login interface

Enter https:/lantispamgateway.comodo.com/user/ in the address bar of any Internet browser.

The login interface of CASG will be displayed.

2 Email User Interface

Username

| |

Password

Login

Forgotten your password?

»  Click the 'Forgot your password?" link.
The 'Forgotten your password?" interface will be displayed.

«  Enter your full username including domain address, for example, ‘johnsmith@exampledomain.com' in the 'Username’
box and click the 'Send password' button.

Anew password will be generated and sent to your email address.

Note : You can use the above option if you are already a CASG user and forgotten your password. If you are a new user,
contact your administrator to add you as a new user and get a password for accessing CASG.

To change the current password
»  Login to the CASG interface.
«  Click the 'Account management' tab on the left hand side navigation to expand and then click the "My profile’ sub tab.

S beiinis Quaranting
Np? Antispam Gateway B

Incoming

Outgoing

Account management

m [y profile

Manage report subscriptions

Comodo Antispam Gateway User Guide | © 2015 Comodo Security Solutions Inc. | All rights reserved 6
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The "My profile' interface will be displayed.
My profile € Heip
Change password

Mew passward

Confirm password -

Change settings

Whitelist my email : [

«  Inthe 'Change password' section, enter the new password and confirm it in the respective boxes and click the 'Save'
button.

Password successfully changed dialog will be displayed.

Success

@ Password was successfully saved.

«  Click 'OK".

Now you can access CASG using the new password.

2.3 How to Manage your Quarantined Mails

You can view the mails addressed to you but identified as spam and quarantined by CASG in two ways:
+  From the Notification email
«  From the CASG User Interface

Quarantine Notification Email

If enabled by the administrator, CASG sends a notification email whenever an email addressed to you is identified as spam and
moved to quarantine. The notification mail will contain a link to view the email content. The link will expire in 24 hours.

An example quarantine notification mail is shown below:

Comodo Antispam Gateway User Guide | © 2015 Comodo Security Solutions Inc. | All rights reserved 7
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New email placed in quarantine.

Sender: bluto@pirateisland.com
Date: Wed Nov 12 12:55:04 EET 2014
Subject: You've got a treasure

To see the quarantined message, click here

For help, see the User guide: hitp.//help.comodo.comffopic-157-1-294-3398-Introduction-to-Comodo-
Antispam-Gateway. htm

Having Trouble? Support is here to help. Open a Ticket at https://support.comodo.com or call
1.888.COMODO (256.2608)

Clicking the link enables you to view the email. But for other actions like releasing the mail, blacklist/whitelist the sender, you
need to login to the CASG user interface and manage the mail as explained below.

Note: The administrator of your email account should have enabled this feature for you. If you are not getting notification mails,
contact your administrator for enabling it.

CASG Quarantine Interface

The 'Quarantine area in CASG allows you to view all your quarantined emails. You can also send requests to administrator to
release quarantined emails or add senders to either whitelist or blacklist. From this interface you can delete a selected or all the
spam mails.

Note: The administrator of your email account should have enabled this feature for you. If you are not able to view and access
your quarantined mail list, contact your administrator for enabling and accessing your quarantined emails.

Tip: You can configure CASG to send Quarantine summary reports periodically to your email. The report will contain a list of
mails identified as spam and were moved to Quarantine automatically by CASG. For more details, refer to How to Subscribe
for Periodical Quarantine Report Summary.

To open the quarantined email interface:

«  Login to the CASG interface.
«  Click the 'Incoming' tab on the left hand side navigation to expand and then click the 'Quarantine' sub tab.

Comodo Antispam Gateway User Guide | © 2015 Comodo Security Solutions Inc. | All rights reserved 8
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S Antispam Gateway

) Incoming Quarz:

m Cuarantine

Manage whiteli
Manage blac
|’-l—‘| Qutgoing

|':E| Account management
- Alternatively, click the 'Quarantine' button at the top.
' cCOMODO - :
i . Cuarantine: 4
p* Antispam Gateway

() Incoming Quarantine

® Ctuarantine

=l Show message
Archive -

Filter=s

The quarantined email area of the user will be displayed.

Quarantine © ren
Show message [ Delete Delete all i ¥ Refresh

‘ 0 Filters |

[[] Subject From To Date (GMT Reason Size* Action
Oct 29, spam

[[] demo spam  admin S 2014 External pattern 1108 A

email 2 <admin@csg.comodo.od.ua= John@ 25503 match bytes
PM (Sanesecurity.Jur
Oct29,  spam

[[] demo spam  admin  hn@docteameas 2014 External pattern 1108 A

email 1 <admin@csg.comodo.od.ua= John@ 25446  match bytes
P (Sanesecurity.Jur

1 i1 [1-212] Perpage |15 w

The quarantined emails are displayed with eight columns providing information about the subject, the sender, details of the

Comodo Antispam Gateway User Guide | © 2015 Comodo Security Solutions Inc. | All rights reserved 9
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recipients, the date it was sent, the reason it was quarantined, the size of the email and if there is any attachment. The last
column indicates the action taken by the user for requests to the administrator such as releasing quarantined emails or to add
the sender to blacklilst or whitelist.

Sorting the Entries

Clicking any column heading switches the sorting of the entries based on the ascending/descending order of the entries as per
the information displayed in the respective column.

Use the filter option to search for particular email. See 'How to use filter options in the Quarantined emails interface' topic
for more details.

Viewing Quarantined Mails

The mails added to the Quarantine can be viewed in two ways:
*  Inthe same CASG window

* Inanew CASG window

Note: The administrator of your email account should have enabled this feature for you. If this is enabled, the 'Show message
button will be available in the interface.

To view quarantined mails in the same CASG window:

» Inthe quarantined email area, select the mail that you want to view and click the 'Show Message' button.

or
«  Click on the email link in the subject column that you want to view its details.

Quarantine Help

=)} Show message m Delete ﬁ Delete all ‘G Refresh ‘
e Filters

+ Subject w | contains v Apply filter

[ Subject From To Date (GM7T 4 Reason Size” | [ Action
, Oct 29, spam
demo spam  admin . External pattern 1108
i . john@docteamcas 2014 ol
email 2 <admin@csg.comodo.od.ua= 955:03 PM match bytes
2 1 i B
(Sanesecurity.Junk

spam

The selected mail will open.

Comodo Antispam Gateway User Guide | © 2015 Comodo Security Solutions Inc. | All rights reserved 10
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Quarantine / E-mail

E'mail e Help

Normal | All headers

|':| Releaze Blacklist this Sender Whitelist this Sender m Delete

Subject  demo spam email 2
From admin <admin@csg.comodo.od.ua=
To john@docteamcasg.comodo.od.ua
cc

Date (GMT

+0) Wed Oct 29 14:55:03 GMT 2014

Size 1108 bytes

Actions
Plain text | Html source | Original View
> Discount Hydrocodone 107325, 60 p. — £199 NEW !!! Hydrocodone 10/500 -

> mg (WATSON 540) - 60 pills $249, Hydrocodone 10/500 mg (WATSON 540) -
> 90 pills £339. Buy NOW!

Having Trouble? Support is here to help. Open a Ticket at support comodo.com or call 1.888.COMODO (256.2608)

By default, the email will open in Normal view and will be displayed in Plain text, where the images, banners and links will be not
be displayed. Clicking the 'Html source' tab displays the email will all the html tags. To view images and links, click the 'Original
View' tab. The user can also request the administrator to release the email or to add the sender to whtelist or blacklist.

Awarning will be displayed before you want to view the selected email in original.

Warning

Y Are you sure you want to view this spam email?
! % This action may harm your personal data. More
info at http:ifen.wikipedia.orgfwiki/Cross-

site_scripting

»  Click 'OK" to view the email.

Comodo Antispam Gateway User Guide | © 2015 Comodo Security Solutions Inc. | All rights reserved 11
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Check the details of the mail and ascertain whether it is @ spam mail or not. You can choose to either release the email or to add
the sender to whtelist or blacklist. If there is an attachment, you can download it from this dialog.

lil Download

Size

& Sleep Awaymp3 6.31 MB

«  Select the attachment and click the download button.

The download dialog will open.

- B
Opening Sleep Away.mp3 p— o ﬂ

You have chosen to open:
|4'| Sleep Away.mp3

which ist MP3 Format Sound
from: http://5.39.28.212:8080

What should Firefox do with this file?

70 Openwith | Windows Media Player (default) -

i@ : Save File

[ Do this automatically for files like this from now on.

oK ][ Cancel

You can open the attachment with an appropriate application or save to a desired location in your computer.

To view the email headers, which contain the tracking information of the mail detailing the path it has crossed before reaching
the recipient, click 'All headers' tab. The headers give full details of the sender, route, recipient, sent date, mail type and so on
and enable you to check the authenticity of the mail.

Comodo Antispam Gateway User Guide | © 2015 Comodo Security Solutions Inc. | All rights reserved 12
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Mormial All headers

1#] Download message

Received : from mail-oa0-165 goagle.com ([209.85.219 65]) -
by msrvl.dev.spamgateway.comodo.com with esmips (TLSv1.RC4-SHA128)
(Exim 4.82)
(envelope-from <fiatliena@gmail. coms=})
id 1WcAR-0000Z9-K5; Mon, 21 Apr 2014 09:38:22 +0000

Received : by mail-0a0-f65.google.com with SMTP id m1s04810660ag.0
for <multiple recipients=; Mon, 21 Apr 2014 02:38:07 0700 (PDT)

DKIM-Signature : v=1, a=rsa-sha256; c=relaxedirelaxed;
d=gmail.com; s=20120113;
h=mime-version:in-reply-to:references:date:message-idsubjectirom:to
:content-type,
bh=P+WwAQTKYGcEUHHM3gINIRHgzYvrX0ds 6ovDASDI=;
b=WhZoEdJuKBTUnVuHZGowSLD4VxLif5eEEiwUy2R5cV+cIL4JPwbpTHV+WiXAwg ]
ONMgCYKytED+P1DCrasSul pté OSurv+cfi+60rWIEBMCIE+EYuTw2gKT G50l 934 k1/9PK 3
mEEJNfuF 0ZYf7iccsa0wsiZsP6Q80g+Qj0AEr+TQb8JKTbbBdzGwIiO0M 3gkkrokMNogF
26 S+ixGgkl 004 dPIbpATBSNEZF JRGWBEV|Bold7tb0gC 116GNBIEGZIEMIAGeulLg1hd
467TNZo1nSJRpJabEyPBL2YKYKE4AWEI211 3PwlooRWNSLchrPY dvdob2Pjgzlod QFYT
CAig==

KIME-Version : 1.0

¥-Received : by 10.60.62 173 with SMTP id z18mr5409380er61.1398073086387; Mon,

21 Apr 2014 02:38:06 -0T00 (PDT)

Received : by 10.182.225 1 with HTTP; Mon, 21 Apr 2014 02:38:06 -0700 (PDT)

In-Reply-To ; <CAFuKkb4jnW_OH_6DnUJSTSTEorPXuk+zig-BedB45GEWgzhZA@mail gmail com=

References | «<53190e1678225_d3832b33815960ba@ip-10-166-191-16.mail>
<CAFuKkbdjnW_OH_6DnUJSTSTEorPXuk+zig-BedfB45GEWgzhZA@mail.gmail. com=

Date : Mon, 21 Apr 2014 15:08:06 +0530

Message-ID : <CAFuKkbSSomTKOp+FIOtgYmRS8u 1LLIUOGnKNt 1cYghTBHGMpaQ@mail gmall.coms= -

If you want to download the email, click 'Download message'. The file will be downloaded as .eml file and can be opened in any
email client.

To view a quarantined mail in a new CASG window

«  Inthe quarantined email area, select the mail that you want to view, right-click on the email link in the subject column
and select to open in a new tab or new window.

Comodo Antispam Gateway User Guide | © 2015 Comodo Security Solutions Inc. | All rights reserved 13
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Quarantine Help
Show message ﬁ Delete E Delete all ‘B Refresh ‘

0 Filters

[[] Subject” From To Date (GM Reason Size il | Action
Oct29,  spam
demo admin , 2014 External 1101
. . ochn@docteamcasg.
spam gmail 2 adrminunen sroomodo o e J @ g 25503 pﬂtte[n match bﬁe ﬂ
Open Link in Mew Tab P {Sanesecurity.
Open Link in Mew Window Oct29,  spam
[E1] der Open Link in Mew Private Window 2014 External 1o
cteamecasg. fl
SPAM g okmark This Link Sl e
. h PM (Sanesecurity..
Save Link As...
Copy Link Location e v i

Search Google for "demo spam email.."

Inspect Element (Q)

The browser may display a warning pop-up window notification. Click the 'Options'> then select 'Allow pop-ups for..." to allow to
open new message in a new window. Click again the 'Show message in new window'.

ig Firefoa peevesbed this site fram egening a popeop wind o,

The details of the selected mail will be displayed in a new CASG window

Comodo Antispam Gateway User Guide | © 2015 Comodo Security Solutions Inc. | All rights reserved 14
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Quarantine / E-mail

E-mail @ Hew

Normal | All headers

|:'| Release Blacklistthis Sender Whitelist this Sender m Delete

Subject demo spam email 2
From admin <admin@csg.comodo.od.ua=
To  john@docteamcasg.comodo.od.ua
cC

Date (GMT
+0)

Size 1108 bytes

Wed Oct 29 14:55:03 GMT 2014

Actions
Plain text | Html source | Criginal View
> Discount Hydrocodone 10,325, &0 p. - $189 NEW !!! Hydrocodone 10,500 .

> mg (WATSON 540) - &0 pills 5249, Hydrocodone 10/500 mg (WATSON 540) -
> 90 pills £33%. Buy NOW!

Having Trouble? Support is here to help. Open a Ticket at support comodo.com or call 1.888.COMODO (256.2608)

To request administrator for releasing quarantined mails:

After viewing and ensuring that the selected email is not a spam you can request your email account administrator to release the
email.

Note: Depending on the permission level configured for your email account by your administrator, the button for releasing
quarantined email will be either 'Release’ or 'Request release’ in the 'More actions' drop-down button. If the interface displays
'Release’ button, you can release the selected email from the list without approval from your administrator.

«  Select the mail that you want to be released and click 'More actions' > 'Release'.

Comodo Antispam Gateway User Guide | © 2015 Comodo Security Solutions Inc. | All rights reserved 15
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Quarantine Help
Show message m Delete ﬁ Delete all ‘B Refresh ‘

o Filters

Blacklist this Sender

[ Subject” From To ason Size fj = Action
Whitelist this Sender
A
demo admin _ 2014 External 1104
. : ochn@docteamcasg.
spamemail 2 <admin@csg.comodo.od.ua= john@ 9 25503 pattern match  byte o
PM (Sanesecurity.
Oct29,  spam
[C] demao admin I T 2014 External 1104 A
spam email 1 <admin@csg.comodo.od.ua> john@ 9 25446 pattern match  Dyte
PM (Sanesecurity..
1 i [1-212] Perpage |15 A"

An email notification will be sent to your administrator for your request and you will also receive the request email. This request
will also be displayed in the 'Action’ column of the users' Quarantined interface. If the administrator accepts the request, the user
will receive the email and if it is rejected, 'Release’ icon in the Action column will no be longer be displayed.

To request administrator for adding senders to blacklist:

To avoid receiving spam emails, you can request the administrator to add the senders of these emails to blacklist.

Note: Depending on the permission level configured for your email account by your administrator, the button for adding
senders to blacklist will be 'Blacklist this Sender' or 'Request blacklist' in the 'More actions' drop-down button. If the interface
displays 'Blacklist this Sender' button, you can add the sender to blacklist without approval from your administrator.

«  Select the mail that you want its sender to be added to blacklist and and click '"More actions' > 'Blacklist this Sender'.

Quarantine Help
Show message m Delete E Delete all ‘G Refresh ‘
Release

— TR
[] Subject* From To ason Size [l = Action
Whitelist this Sender
_-4m
demo admin . 2014 External 1104
. : hn@doct ]
spam email2 =admin@csg.comodo.od.ua= jonn@ €aMEasy. 5 5603 pattern match  byte o
PM (Sanesecurity.J
Oct29,  spam
[C] demo admin hn@docteameas 2014 External 1104 8
spam email 1 <admin@csg.comodo.od.ua> lohn@ 9 25446 pattern match  Dyte
PM (Sanesecurity.J
1 i [1-212] Per page |15 w

An email notification will be sent to your administrator for your request and you will also receive the request email. This request

Comodo Antispam Gateway User Guide | © 2015 Comodo Security Solutions Inc. | All rights reserved 16
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et

will also be displayed in the "Action’ column of the users' Quarantined interface. If the administrator accepts the request, the
sender will be added to blacklist and the user will no longer receive any mail from that sender. If the request is rejected, 'Blacklist
this Sender" icon in the Action column will no be longer be displayed.

To request administrator for adding senders to whitelist:

If the incoming mails of authenticated senders are quarantined, you can request the administrator to add these senders to
whitelilst.

Note: Depending on the permission level configured for your email account by your administrator, the button for adding
senders to whitelist will be 'Whitelist this Sender' or 'Request whitelist' in the 'More actions' drop-down button. If the interface
displays 'Whitelist this Sender' button, you can add the sender to whitelist without approval from your administrator.

»  Select the mail that you want its sender to be added to whitelist and click 'More actions' > 'Whitelist this Sender'.

Quarantine Help
Show message m Delete ﬁ Delete all ‘B Refresh ‘

Releaze

o Filters

Blacklist this Sender

[] Subject” From To ason Size [l = Action
_-am
demao admin hn@docteamcas 2014 External 1104 i
spam email 2 <admin@csg.comodo.od.ua= john@ 9 25503 pattern match byte
P (Sanesecurity..
Oct28,  spam
[7] demao admin hn@docteamcas 2014 External 110¢ A
spam email 1 <admin@csg.comodo.od.uas john@ 9 25446 pattern match Dyte
P (Sanesecurity..

Perpage |15 w

[1-212]

An email notification will be sent to your administrator for your request and you will also receive the request email. This request
will also be displayed in the 'Action’ column of the users' Quarantined interface. If the administrator accepts the request, the
sender will be added to whitelist and the mails from them will no longer be quarantined. If the request is rejected, 'Whitelist this
Sender' icon in the Action column will no be longer be displayed.

2.4 How to Use Filter Options in the Quarantined Emails

Interface

You can use the filtering option in the Quarantined mails interface to optimize your search.

«  Click anywhere on the Filters tab to open the filters area of the Quarantine interface.
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Help

Quarantine

Show message | [[J Delete Delete all ‘G Refresh ‘
Q Filters

+ Subject w | |contains w Apply filter

[] Subject From To Date (GMT Reason Size” i Action
Oct 29, spam
[C] demo spam  admin _ 2014 External pattern 1108
john@docteamcas ,, __ . . bvie ]
el R matcn oyies

email 2 <admin@csg.comodo.od.uaz

You can add more filters by clicking + for narrowing down your search.

Help

Quarantine
Show message | [[J Delete Delete all ‘G Refresh ‘

o Filters

'l' Subject w | |contains v Apply filter

Subject

& _';mm To Date (GMT Reason size | Action
[}
Date Oct29,  spam

[l di size (KB) | ohnmdocteameas 2014 Extemalpatterm 1108

email=

You can remove a filter by clicking the == icon beside it.

Available filters are:

Subject: Will execute a search of subject according to the text entered in the text box (column 3) and the condition
selected in column 2.

From: Will execute a search of senders according to the text entered in the text box (column 3) and the condition
selected in column 2.

To: Will execute a search of users according to the text entered in the text box (column 3) and the condition selected
in column 2.

When you select any one of the above options in the first drop-down, the following conditions are available:

- Contains: Displays all quarantined mails that contain the words entered in the text box
« Not Contains: Displays all quarantined emails that don't contain the words entered in the text box

Other options available in the first drop-down in the filters area:

Date: Will execute a search of mail received dates according to the date selected in the calendar box (column 3) and
the condition selected in column 2.
- Size (KB): Will execute a search of mails according to the size selected or entered in third field (column 3) and the
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condition selected in column 2.
If 'Date’ is selected, the following conditions are available:
«  Equals: Displays the quarantined emails that have the same date as the selected date in the third box from the

calendar

«  Less than: Displays the quarantined emails with dates less than the selected date in the third box from the
calendar

«  Greater than: Displays the quarantined emails with dates greater than the selected date in the third box from the
calendar

If 'Size' is selected, the following conditions are available:

«  Less than: Displays the quarantined emails with size less than the selected or entered size in the third box
- Greater than: Displays the quarantined emails with size greater than the selected or entered size in the third box
Click 'Apply Filter' after selecting the filters.

«  Click anywhere on the Filters tab to close the filters area.

_ +* Refresh _ _ _
e Click the button to display all the quarantined emails.

Note: To display all the quarantined emails after using the filters option, you have to first click anywhere on the Filters tab to
close the filters area and then click the 'Refresh’ button.

2.5 How to Check when an Expected Email is not
Received

You are expecting an important email, but it is not in your inbox. The CASG filtering engine would have most probably classified
it as spam and quarantined. Search for it in the 'email quarantined' area.

To search for a particular email in the quarantine interface

«  Login to the CASG interface.
«  Click the 'Incoming' tab on the left hand side navigation to expand and then click the 'Quarantine' sub tab.

cCoMODO
¥ Antispam Gateway

&) Incoming QUET'

® Cluarantine

Archive

Manage whitelist se

Manage b

1y Outgoing

il
[ Account management

- Alternatively, click the 'Quarantine' button at the top.
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comobo D
N Antispam Gateway T

A Incomi '
() Incoming Quarantine

B Cluarantine

=l Show message
Archive -

All your quarantined emails will be displayed like shown in the example below.

Quarantine © Hep
show message  [[J Delete [E Delete all +_* Refresh

‘ o Filters |

[F] Subject From To Date (GMT Reason size [l Action
Oct29,  spam

[C] demo spam  admin hn@docteamcas 2014 External pattern 1108 A

email 2 <admin@csg.comodo.od.uas John@ 25503  match bytes
P (Sanesecurity.Jur

Oct 29, spam

[[] demo spam  admin hn@docteamcas 2014 External pattern 1108 i
email 1 <admin@csg.comodo.od.ua= John@ 2:54:46 match bytes
PM (Sanesecurity.Jur
1 i1 [1-212] Perpage |15 W

Note: Depending on the permission level configured for your email account by your administrator, the buttons in the interface
may vary. For example, 'Show message' button may not be available in the interface. In 'More actions' drop-down button, the
‘Release’ may appear as 'Release’ button enabling you to release quarantined mail without approval from the administrator.

The quarantined emails are displayed with eight columns providing information about the subject, the sender, details of the
recipients, the date it was sent , the reason it was quarantined, the size of the email and if there is any attachment. The last
column indicates the action taken by the user for requests to the administrator such as releasing quarantined emails or to add
the sender to blacklilst or whitelist.

Sorting the Entries

Clicking any column heading switches the sorting of the entries based on the ascending/descending order of the entries as per
the information displayed in the respective column.

«  Use the filter option to optimize your search. Click here for more details.

»  Click here to know how to manage your quarantined mails.
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Tip: You can configure CASG to send Quarantine summary reports periodically to your email. The report will contain a list of
mails identified as spam and were moved to Quarantine automatically by CASG. For more details, refer to How to Subscribe
for Periodical Quarantine Report Summary.

2.6 How to Retrieve an Email which had Virus Attachment

CASG will quarantine all your incoming emails that it has classified as spam or with virus or with any other suspicious
attachment after the filtering process. You can retrieve your quarantined emails from the 'Quarantine' area in CASG.

To retrieve quarantined mails with attachments

»  Login to the CASG interface.

«  Click the 'Incoming' tab on the left hand side navigation to expand and then click the 'Quarantine' sub tab.

cCOMODO s
S Antispam Gateway T

) Incoming

® Cuarantine

telist senders
Manage bla senders
|’-l—‘| Qutgoing

2 ]
[t3 Account management

«  Alternatively, click the 'Quarantine’ button at the top.

I Antisoarn o Quarantine: 4
g Antispam Gateway Quarantine:

) Incoming

B (luarantine

Quarantine

=)} Show message
Archive -

Filters

All your quarantined emails will be displayed like shown in the example below.
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Quarantine Help
Show message m Delete ﬁ Delete all ‘G Refresh ‘

o Filters

] Subject From To Date (GMT Reason size” | fi Action
Oct29,  spam

[C] demo spam  admin S A m— 2014 External pattern 1108 A

email 2 =admin@csg.comodo.od.ua= Johne 2:55:03 match bytes
P (Sanesecurity.Jur
Oct 29, spam

[C] demo spam  admin R — 2014 External pattern 1108 A

email 1 <admin@csg.comodo.od ua> Johne 2:54:46 match bytes
P (Sanesecurity.Jur

1 i1 [1-2/2] Perpage |15 w

The quarantined emails are displayed with eight columns providing information about the subject, the sender, details of the
recipients, the date it was sent , the reason it was quarantined, the size of the email and if there is any attachment. The last
column indicates the action taken by the user for requests to the administrator such as releasing quarantined emails or to add

the sender to blacklilst or whitelist.

Sorting the Entries

Clicking any column heading switches the sorting of the entries based on the ascending/descending order of the entries as per
the information displayed in the respective column.

»  Use the filter option to optimize your search. Click here for more details.

«  After identifying the email with attachment that you suspect to be virus, select it and click the 'Show Message' button
or click on the email link in the "Subject' column to view its details. If you want the mail to be opened in a new CASG
window or tab, right-click on the email link in the 'Subject’ column and select from the context sensitive menu options.

Note: The administrator of your email account should have enabled this feature for you. If this is enabled, the 'Show message
button will be available in the interface.

Quarantine Help

(=] Show message m Delete Delete all ‘G Refresh ‘
o Filters

+ Subject w | containg v Apply filter

[[] Subject From To Date (GM7 1 Reason size” | fi Action
_ Oct 29, spam
demo spam  admin . External pattern 1108
. . john@docteamcas 2014 fl
email 2 <admin@csg.comodo.od.ua> 26503 py  Mateh bytes
. L ¥ .
(Sanesecurity.Junk

spam
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The selected email will open.

GQuarantine / E-mail
E-mall @ Heip

Hormal | All headers
|:| Release Blacklist this Sender Whitelist this Sender m Delete

Subject  demo spam email 2
From admin <adming@csg.comodo.od.ua>
To john@docteamcasg.comodo.od.ua
cC

Date (GMT

+0) Wed Oct 29 14:55:03 GMT 2014

Size 1108 bytes

Actions

Plain text | Html source | Criginal View

> Discount Hydrocodone 10,325, 60 p. - £199 NEW !'!! Hydrocodone 104500
> mg (WATSON 540) - &0 pills $243, Hydrocodone 10/500 mg (WATSON 540) -
> 80 pills £339. Buy NOW!

Having Trouble? Support is here to help. Open a Ticket at support. comodo.com or call 1.888.COMODOD (256.2608)

By default, the email will open in Normal view and will be displayed in Plain text, where the images, banners and links will be not
be displayed. Clicking the 'Html source' tab displays the email will all the html tags. To view images and links, click the 'Original
View' tab.

The user has to request the administrator to release the email for retrieving it and also to add the sender to whtelist or
blacklist.

A warning will be displayed before you want to view the selected email in original.
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Warning

/o Are you sure you want to view this spam email?
.i] This action may harm your personal data. More
info at hitp:ifen. wikipedia.orgfwiki/Cross-

site_scripting

K =3

«  Click 'OK' to view the email.

Check the details of the mail. You can choose to either release the email or to add the sender to whtelist or blacklist. If there is
an attachment, you can download it from this dialog.

1#) Download
Size

@ Sleep Awaymp3 6.31 KB

»  Select the attachment and click the download button.

The download dialog will open.

-
Opening Sleep Away.mp3

You have chosen to open:
|4'| Sleep Away.mp3

which ist MP3 Format Sound
from: http://5.39.28.212:8080

What should Firefox do with this file?

70 Openwith | Windows Media Player (default) -

@) i Save File

[] Do this automatically for files like this from now on.

oK ][ Cancel

You can open the attachment with an appropriate application or save to a desired location in your computer.

The selected email will be delivered to your inbox only when the administrator has accepted your request for releasing it.

Note : Antivirus application in your computer may prevent an attachment that contains virus from downloading. To download
the attachment, disable the antivirus option in your computer.
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2.7 How to Subscribe for Periodical Quarantine Report
Summary

Comodo Antispam Gateway can periodically generate quarantine reports that are sent to the users. The reports will be sent
routinely at the times selected by the user.

Note: The administrator of your email account should have enabled this feature for you. If this is enabled, the 'Manage report
subscriptions' sub tab will be available in the left hand side navigation area under the 'Account management' tab.

The Quarantine Report contains a statistical breakdown of the mails that were identified as spam or containing malicious content
and were moved to Quarantine automatically by CASG, with the details of sender, receiver, date and attachments. Clicking the
subject line in the list will open the respective mail in a new CASG window. Refer to CASG Reports - An Overview for more
detalils.

The report can be subscribed to be received daily, weekly or monthly.
To configure subscription of the report
«  Login to the CASG interface

«  Click the 'Account management' tab on the left hand side navigation to expand and then click the 'Manage report

subscriptions' sub tab.
COMODO
Antispam Gateway

3 Incoming Ma :

|1-| Account management

Iy prafile

The 'Manage report subscriptions' interface will be displayed.
Manage report subscriptions @ e

Quarantine report

Hour Day of month Day of week Send empty Enabled Start date (GMT) Report length
@ Every day @ Every week day
©ichoose ©iChoose
'::' D - - wl il f ) -
® 1 D ) D o MNext report for 1
- - B [ Oct 30,2014 04:00  day(s) from last run
B 2 3 Tuesday (2014-10-29 04:00)
|:| 3 4 ednesds
4 - 5 - T -

Reset settings to default

« If you want to receive the periodical Quarantine summary reports, ensure that the 'Enabled' check box is selected.

»  Leave the 'Send empty' checkbox unchecked if empty reports are not to be sent to recipients.
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«  Select the frequency of the report to be sent to you from the 'Hour', 'Day of month' or 'Day of week' columns.

»  Hour - The reports will be generated and sent at the selected hour of the day or date chosen from 'Day of month'
or 'Day of week' columns.

- Day of month - The reports will be generated and sent every day or on the specific day every month chosen at
the hour selected from the "Hour' column.

- Day of week - The reports will be generated and sent every day or on the specific day every week chosen at the
hour selected from the "Hour' column.

- Start date - Displays the start date of the report generation depending on the options chosen.
«  Report length - Displays the period of the report that will be generated depending on the options chosen.

«  Click 'Save' for your settings to take effect.

»  Click 'Reset settings to default' button to configure default report generation period. The report will be generated every
24 hours starting from last report generated time or from 00:00 hours.

2.8 How to Perform a Log Search of your Incoming Emails

The Log Search option in CASG allows you to search for email messages based on the parameters entered or selected in the
interface.

Note: The administrator of your email account should have enabled this feature for you. If this is enabled, the 'Log search' sub
tab will be available in the left hand side navigation area under the 'Incoming’ tab.

To perform a log search of your incoming emails
»  Login to the CASG interface.
»  Click the 'Incoming' tab on the left hand side navigation to expand and then click the ‘Log search' sub tab.

COMDDO
' Antispam Gateway

£5) Incoming

Quarantine

Idanage whitelist senders
Manage Macklis! senders

|l| Cutgoing

r:.:l Account management

The 'Log search (incoming)" interface of the user will be displayed.
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Log search (incoming) Help

Date range: |2014-10-28 PM 03:08:06 E] -|20714-10-29 PM 03:08:06  |-=

Message ID:

Sender.
Recipient: [john @docteamcasg.comodo.od.ua

Sender IP

Sender host:

Include results from the last minutes: [

search

(1]

- Date range: Select the date range for which you want to search the log file.
«  Message ID - Enter a unique message identifier (optional )

«  Sender: Enter the sender email address in this field.

«  Recipient: The currently logged in user name will be displayed in this field.
< Sender IP: Enter the IP address of the sender.

«  Sender Host: Enter the sender host name.

» Include results from the last minutes: If selected, CASG will include messages that are currently being migrated
from the filtering server to the logging server in the search results.

The optian “Indude resuis from the last minutes™ will kew down the search resut retrieval u

»  Click the 'Search' button.

CASG will search for the entered terms and display the results.

Date and time~ Host (Eximid}- = Sender hostnan Sender Recipient Subject Classification
Rejected
2014-10-29 mxsrv3.spamgat mxsrv3.spamgat ) : demo spam
, admin@csg.com john : External pattern
14:53:43 1XjUd0-0006VE-\ 178.33.199.69 @csg J email 1 P
match
mxsrv2.spamgat Rejected
2014-10-29 ) j
1XjUUf- mxsrv2.spamgat demo@csg.com john Spam email 1 Rejected h'_'l" .
14:45:07 178.33.199.66 relay restriction
0001RZ-B8 : .
for this recipient
mxsrvl.spamagat Rejected
2014-10-29 i j
s TXJUUX- mxsrv2.spamgat demo@csg.com john Spam email 2 Rejected h]r .
14:44:58 . 178.33.199.66 relay restriction
0006MY-Bj : - r
for this recipient
1 f1 [1-3/3] Perpage |15 W
Sorting the Entries

Clicking any column heading switches the sorting of the entries based on the ascending/descending order of the entries as per
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the information displayed in the respective column.

2.9 How to Add or Remove a User from Recipient Whitelist

All filtering checks in CASG are disabled for whitelisted recipients. You have the option to add or remove yourself from recipient
whitelist.

Note: The administrator of your email account should have enabled this feature for you. If this is enabled, the 'Change
settings' section will be available in the 'My profile" interface.

To add or remove from recipient whitelist
«  Login to the CASG interface.

«  Click the 'Account management' tab on the left hand side navigation to expand and then click the "My profile' sub tab.

1 cCoOMODO
Antispam Gateway

(3] incoming M}

|i| Outgoing

5 Account management

m RAly profile

Manage reporn Supscplins

The 'My Profile' interface will be displayed.

My profile © Heip

Change password

Mew password

Confirm password

Change settings

Whitelist my email : [7]

« Inthe 'Change settings' section, select or deselect the "Whitelist my email' checkbox to add or remove yourself from
the Recipient Whitelist.

»  Click 'Save'to confirm your changes.
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2.10  How to Report Spam Emails

The Report Spam feature allows you to report suspected junk emails that have by-passed existing filters and landed in your
inbox. CASG will analyze reported mails and, if found to be spam, will update its filters to quarantine similar mails in future. You
can upload spam mails locally saved in your system into this area.

Note: The administrator of your email account should have enabled this feature for you. If this is enabled, the 'Report spam'’
sub tab will be available in the left hand side navigation area under the 'Incoming’ tab.

To report a spam mail
«  Login to the CASG interface.

«  Click the 'Incoming' tab on the left hand side navigation to expand and then click the 'Report spam'’ sub tab.

y coMODOD
® Antispam Gateway

Archive

B Fepon spam

Manage blacklist se
|i‘:- Quigoing

E! Account management

The Report Spam interface will be displayed.

Report spam © Heip

Upload .eml format files only (max. size - 9 Mb)

14 Upload

«  Click the 'Upload' button.

Note: The files should be email format (with .eml extension) and its size should not exceed 9 MB. The following error message
will be displayed if any of the above is not complied with.

Perhaps the body of the file is damaged o i Is nat * emi farmat or it size greater than OMD (outgoing_users.csv) [x]

- Navigate to the location where the suspected email(s) is/are stored in your system. Select the mail that you want to
report as spam and click 'Open'. The maximum size of the file that can be uploaded is 9 MB.
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(= angel Beauty © inic.
59 Apply, Get Real Quotes For Top Plans. Go With The Best Offer
54 Europe Lotkery - Yoo waon £500,000

ES MY CaNADTAN PHARMACY

54 Your Email Id has won 1,000,000,00 GEP in the British Microsoft Inc,

File name: I.ﬁ.ngel Beauty Clinic j Open I
Files of tpe: I,-‘.‘-.II Files [*.%] j Cancel |
g

The mail will be processed for uploading and success message will be displayed after the process is completed.

Report spam @ Heip
Spam reported successfully

Upload .eml format files only (max. size - 9 Mb)

2.11  How to Perform a Log Search of your Outgoing Emails

In the outgoing Log Search interface, you can search sent email messages based on filters such as date range, recipient email
address, sender IP and classification.

Note: The administrator of your email account should have enabled this feature for you. If this is enabled, the 'Log search’ sub
tab will be available in the left hand side navigation area under the 'Outgoing' tab.

To perform a log search of your outgoing emails

«  Login to the CASG interface.

Click the 'Outgoing' tab on the left hand side navigation to expand and then click the ‘Log search' sub tab.
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G

i"l\'- T
) INCOming

: Lo
!L Dutgoing

B | ogs=sarch

3 Account management

The 'Log Search (Outgoing)' interface of the user will be displayed.

Log search (outgoing) @ Help

Date range: |2014-10-28 PM 03:14:14 m -12014-10-29 PM 03:14:14 L]

Message ID:
Sender. |John @docteamcasg.comodo.od.ua
User. @docteamcasg.comodo.od.ua

Recipient:

Sender IP.

Sender host:
Classification: |All v

Include results from the last minutes: D

- Date range: Select the date range for which you want to search for the sent mails.

«  Message ID - Enter a unique message identifier (optional )

«  Sender: The currently logged in user name will be displayed in this field.

«  User: Enter the username of the outgoing email address for in this field (for example, ‘testuserl@example.com’).

»  Recipient: Enter the email address of the recipient (for example, 'testuserl@domain.in’) that you want to search for
sent mails.

«  Sender IP: Enter the IP address of the sender.
«  Sender host: Enter the sender host name.
- Classification: Select the type of email that you want to search from the drop-down options.

» Include results from the last minutes: If selected, CASG will include messages that are currently being migrated
from the filtering server to the logging server in the search results.

The optian “Include resufis from the last minutes™ will slow down the search resul retrieval u

»  Click the 'Search' button.

CASG will search for the sent mails based on the filters entered and / or selected and display the results.
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et

Date and tiriie Host (Eximid) Sender hosin, User Sender Recipient Subject Classification
Mxsrv3.spamg . :
2014-10-29 outgoin Accepted
?4,4915‘ 1XUYS- ;115"'3;:3?220' john ohn@doctean demo2@docte __ ;_pm;ﬁ '
49 196.95. bject 2
0005Ws-0H J
mxsnv2.spamg )
2014-10-29 ) mail2.comodo. ; outgoing Accepted
1XJUYF- john john@doctean demo@docte }
14:48:43 91.196.95.33 subject
0002Do-AU .
1 i1 [1-212] Perpage |15 W

The 'Download' button allows users to download the log report of sent mails for the filters entered and/or selected.
»  Click the 'Download' button.

The download dialog will be displayed.

- B
COpening cutgeing.docteamcasg.comodo.od.ualogs.zip M

You have chosen to open:

g outgoing.docteamcasg.comodo.od.ua.logs.zip
which is: WinRAR ZIP archive

from: . & -

What should Firefox do with this file?

) Openwith |WinRAR.ZIP (default) -

@) Save File

[] Do this automatically for files like this from now on.

O l ’ Cancel

You can choose to open the file by using the browse option or save the file in your system. The compressed log file will be saved
in the folder that you have configured for saving download files. The values in the log report will be separated by commas and
this file can be opened with appropriate application such as Excel or Openoffice Calc for easy analysis.

Sorting the Entries

Clicking any column heading switches the sorting of the entries based on the ascending/descending order of the entries as per
the information displayed in the respective column.

2.12  How to Manage Archived Mails

CASG is capable of storing a copy of all incoming mails for all users belonging to an account and allows you to:

«  View the list of emails received at your email address
*  Read your mails, download attachments and reply to them
«  Resend mails to your mail box if the original mail was lost

»  Report mails as spam

Note: The administrator of your email account should have enabled this feature for you. If this is enabled, the 'Archive’ sub tab
will be available in the left hand side navigation area under the ‘Incoming' tab.
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To open the Archive interface
«  Select the 'Incoming' tab from the left hand side navigation, then click the ‘Archive' tab.

(¥) Incoming
Quarantine

Arciine

|l| Oubgoing

[ Account management

Your Email Archive interface will open with a list if emails received for your email address.

Archive © Hen

[T] Show reported as spam “ a Refresh

| Show message /N Reportspam ‘& Resendemail 5 Reply | 59 Replyall

| £ Fiters |

[] Subject From To Date (GMT +0) Size ﬂ Action
Tue Jan 20

. dagwood bumpsted .

mail frem Dagwood : : john@docteamcasg. 06:43:58 GMT 7.64 KB fl

<avantistude@gmail.com:=

2015
Tue Jan 20

- dagwood bumpsted

v i john@docte . 06:49:

mail from Dagwood R john@ amcasg. 06:49:58 GMT 414 KB ﬂ
2015

) Thu Oct 30
[ Quarantine Report for admin@antispamgateway.c john@docteamcasg. 04:00:51 GMT 2322 KB ]

john@docteamcasg.comodo.od.ua

Sorting the Entries

Clicking any column heading switches the sorting of the entries based on the ascending/descending order of the entries as per
the information displayed in the respective column.

Using the Filter option to search archived emails

«  Click anywhere on the 'Filters' tab to open the filters area.
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Archive Help
Show message /M Reportspam & Resendemail 757 Reply  ¥=5 Reply all [C] 8how reported as spam || D Refresh ‘
@ Filters
+ Subject + | contains v Apply filter
[l Subject From To Date (GMT +0) Size ﬁ] Action

You can add more filters by clicking + for narrowing down your search.

Archive Help
@ Show message & Report spam & Resend email =3 Reply 3 Reply all [C] Show reported as spam || 8 Refresh ‘
@ Filters
+ Subject v | |contains w Apply filter
== |From v  |contains v
== |Date v | |equals v ]
= |Subject v | |contains v

| subject 5
| |

[ 4 imm I | From To Date (GMT +0) size ] Action

| To |

Date Lo . Tue Jan 20
1 Size (KB) b ' : Gl

| Attachments |

You can remove a filter by clicking the ™= icon beside it.

Available filters are:

- Subject: Will execute a search of subject according to the text entered in the text box (column 3) and the condition
selected in column 2.

- From: Will execute a search of senders according to the text entered in the text box (column 3) and the condition
selected in column 2.

«  To: Will execute a search of users according to the text entered in the text box (column 3) and the condition selected
in column 2.

When you select any one of the above options in the first drop-down, the following conditions are available:

«  Contains: Displays all archived mails that contain the words entered in the text box

« Not Contains: Displays all archived emails that don't contain the words entered in the text box
Other options available in the first drop-down in the filters area:

- Date: Will execute a search of mail received dates according to the date selected in the calendar box (column 3) and
the condition selected in column 2.

- Size (KB): Will execute a search of mails according to the size selected or entered in third field (column 3) and the
condition selected in column 2.
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- Attachments: Will execute a search of mails according to the checkbox status (column 3) whether enabled or
disabled. If enabled, all archived mails with attachments will be displayed.

«  Marked as retained: Will execute a search of mails according to the checkbox status (column 3) whether enabled or
disabled. If enabled, all archived mails that are marked as retained will be displayed.

If 'Date’ is selected, the following conditions are available:

«  Equals: Displays the archived emails that have the same date as the selected date in the third box from the
calendar

«  Less than: Displays the archived emails with dates less than the selected date in the third box from the calendar

«  Greater than: Displays the archived emails with dates greater than the selected date in the third box from the
calendar

If 'Size' is selected, the following conditions are available:

»  Less than: Displays the archived emails with size less than the selected or entered size in the third box
- Greater than: Displays the archived emails with size greater than the selected or entered size in the third box

«  Click 'Apply Filter' after selecting the filters.
The application will search the respective column(s) according to the filter(s) set and display the resullt.
«  Click anywhere on the Filters tab to close the filters area.

The emails by accidentally have sent to spam might be displaced to Archive. Click the 'Show reported as spam'’ button to view all
reported as spam emails. For data-intensive you can use Filters criteria.

+ * Refresh
«  Click the button to display all the archived emails.

Note: To display all the archived emails after using the filters option, you have to first click anywhere on the Filters tab to close
the filters area and then click the 'Refresh’ button.

From this interface you can:

«  View mails

*  Report mails as spam

* Resend mails

«  Send Replies to mails
Viewing Archived Mails
You can view the mails, download attachments, reply to them and more from the 'Archive' interface.
To view an archived mail

»  Select the mail that you want to view and click the 'Show Message' button.

or

«  Click on the email link in the subject column that you want to view.
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Archive Help

Zh show meszage

6 Filters

/\ Reportspam ‘= Resendemail ¥ Reply =7 Replyall [T] Show reported as spam ||D Refresh ‘

[[] Subject From To Date (GMT +0) Size fi Action
Tue Jan 20
) dagwood bumpsted _
[T] mail from Dagwood ) ) john@docteamcasg. 06:49:58 GMT 7.64 KB @
<avantistude@gmail.com=
2015
5 dagwood bumpsted _ B
mail from Dagwood ) ) john@docteamcasg. 06:49:58 GMT 414 KB i
<avantistude@gmail.com:=
2015
. ) Thu Oct 30
Quarantine Report for admin@antispamgateway.c john@docteamcasg. 04:00:51 GMT 23.22 KB il

john@docteamcasg.comodo.od.ua

The selected email will be displayed.

Tip: You can also choose to open the mail on a different browser tab or browser window. Right-click on the email link in the
subject column and select to open it in a new tab or new window.

dagwood bumpsted ) Thl'? ]
i ohn@docteamcasg.comodo.od.ua 11
O m john@dect q do.od.ua 11:0
Open Link in New Tab Lan o
Open Link in New Window ™
-~ Fuf Open Link in New Private Window ) john@docteamcasg.comodo.od.ua | o
Upto 3 fahoo.co.in=
Bookmark This Link
Fy Share This Link
Cards Save Link As...
Ceopy Link Location
Search Google for "Mail from Dagwe...”
Inspect Element (Q)

The browser may display a warning pop-up window natification. Click the 'Options'> then select 'Allow pop-ups for..." to allow to
open new message in a new window. Click again 'Show message in new window'.

ig Firefoa peevesbed this site fram egening a popeop wind o, L Dipeiens | =

The selected mail will be displayed in a new CASG window.
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Archive / Archive mail

Archive mail © Hen

Normal All headers

/N Reportspam (3 Resendemail 57 Reply =7 Replyall

Subject  Mail from Dagwood
From dagwood bumpsted <avantistude@gmail.com:=
Te  jehn@docteamcasg.comodo.od.ua
CC

Date (GMT
+0)

Size 3.75KB

20153-01-2211:01:31

Actions

Plain text | Html source Original View

Hai John,

L3 discussed over phone, I would like to confirm cur meeting on Saturday. I
will be at wour office at eight 0' clock in the morning.

Regards,
Dagwood.

By default, the email will open in 'Normal' view and will be displayed in Plain text, where the images, banners and links will not
be displayed.

«  Toview images and links, click the 'Original View' tab.
«  To view the mail with all HTML tags, click the 'Html source' tab.

- To view the emalil headers, which contain the tracking information of the mail detailing the path it has crossed before
reaching the recipient, click 'All headers' tab in the upper pane. The headers give full details of the sender, route,
recipient, sent date, mail type and so on.

«  To download attachments, select the attachment from the lower pane and click 'Download'

ACTICNs

Plain text Html source Original View

Hi John,

Lttached is the proposal which we are going to discuss in cur Saturday
meeting.

Regards,
Dagwood.

Att

1+ Download

Hame Size

john_proposal.doc 18.47 KB

The buttons at the upper pane enable you to:
»  Report the mail as spam;

»  Resend the mail to your mail box; and
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*  Reply to the mails.
Report the mail as spam

If the mail appears to be a spam after reading it and viewing the details, you can choose to report it as a spam to CASG for
quarantining such mails in future.

- Toreport the mail as a spam click the 'Report spam' button at the top left of the upper pane. A confirmation dialog will
appear.

Normal All headers
/1 Report spam f;" Resend email 5 Reply 55 Replyall

Subjedt  Mail from Dagwood
Fro dagwood bumpsted <avantistude@gmail.com=

To | john@docteameasg.comodo.od.ua

cC

Date (GMT

Report as spam

_/@‘ Are you sure you want to mark the selected

emails as spam?

»  Click 'OK"in the confirmation dialog.

Tip: You can report several mails as spam at once from the Archive Mall interface. Refer to the explanation under Reporting
mails as spam for more details.

Resend the mail to your mailbox

CASG allows you to restore your mails from its archive, in case the original mail was lost. You can forward the currently viewed
mail your mail box.

Tip: You can resend several mails from the archive to your mailbox at once from the Archive Mall interface. Refer to the
explanation under Resending mails to your mailbox for more details.

- Toresend the mail click the 'Resend email' button from the upper pane. A confirmation dialog will appear.

Normal | All headers

/A Reportspam (2 Resend email

¥+ Reply | i Reply all
Subject  Mail from Dagwpod
From  dagwood burmngsted <avantistude@gmail com:=

Te  john@docteaq
cC

casg.comodo.od.ua

Date (GMT
+0]

@ Are you sure you want to resend selected
email{s) to recipient mailbox?

Comodo Antispam Gateway User Guide | © 2015 Comodo Security Solutions Inc. | All rights reserved 38



Comodo Antispam Gateway - User Guide coMoDo

Creating Trust Online®

»  Click 'OK"in the confirmation dialog.

The mail will be sent only to your mail box and NOT to other recipients in the TO or CC/BCC fields.

Reply to the mail

You can send reply to the currently viewed mail from the CASG interface, without having to open the mail from your mail client.
«  Toreply only to the sender, click the 'Reply" button from the upper pane

« Toreply to all in the mailing list, including the recipients in the CC list, click the 'Reply all' from the upper pane

Normal All headers

/N Reportspam & Resendemdl | I Reply I Replyall

Subject  Mail from Dagwood

From  dagweood bumpsted <avantistude@mail.com:=

To  john@docteamncasg.comogh

Reply all

To Dagwoed Bumpsted <avantistude@gmail come, jehniidocteameasg.comodo.od.ua
Subject RE: Mail from Dagwood

Reply text

Original message

Hai John,

As discussed over phone, | would like to confirrm our meeting on Saturday. | will be at your office at eight O clock in the morning

Regards,
Dagwood.

1 2

You can enter your text in the upper text box and click 'Send' to reply to the mail.
Reporting mails as spam

You can report the mails that you consider as spam from the Archive interface. CASG will process those mails and if found to be
spam, will move them to quarantine.

To report mails as spam

«  Select the mails that you want to report as spam and click 'Report spam'.
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Archive

‘% Resendemail ¥ Reply = Reply all [ Show

@ Show message

.& Report spam

_ @ Filters

[[] Subject From To Date {C
Fri Jz
joh ith
[T Fwd: test fenn _Sml . jehn@docteamcasg.comodo.od.ua 07:15
<fiatliena@gmail.com:= N
2015
wd. Case Study: How Epson b smith Frida
Uses EyeQuant to Boost Conversion ) ; jehn@docteamcasg.comodo.od.ua 0714
1atliena@gmail.com:= i
Rates 2015
S 5 Fri Jai
- el y jehn@docteamcasg.comodo.od.ua  07:11
H i
2015

: Fri Jz
ohn@docteamcasg.comodo.od.ua,
i L

1 Client Mesting

Report as spam

= Are you sure you want to mark the selected
L@ emails as spam?

KN =3

«  Click 'OK"in the confirmation dialog.

‘Spam reportad suctesstully

Viewing the Mails You Reported as Spam

You can identify the emails that you reported as spam in the past from the 'Archive' interface by clicking the 'Show reported as
spam checkbox' at the top right. The mails will be identified by the yellow icon % in the Action column in the right.
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Archive €
Show message /N Reportspam ‘& Resendemail ¥ Reply | 57 Replyall SQDW reported EBSPEmlm

| @ Filters

[] Subject

[T Fwd: test

Fwd: Case Study: How Epson
uses EyeCluant to Boost Conversion
Rates

[ Fwd; et o ity ol e
S

[T] client Meeting

Mail from Dagwood

From

jehn smith
<fiatliena@gmail.com=

john smith
=fiatliena@gmail.com=>

jehn smith
<fiatliena@gmail.com=

dagwood bumpsted
zavantistude@gmail.com:

dagwood bumpsted

=gvantistude@gmail.com:

Resending mails to your mail box

COMODO

Creating Trust Online®

Help

Refresh ‘

To

john@decteameasg.comodo.od.ua

john@docteamcasg.comodo.od.ua

john@decteameasg.comodo.od.ua

john@docteameasg.comodo.od.ua,
fiatliena@gmail.com

john@docteameasg.comodo.od.ua

Date (GMT fil Action

Fri Jan 23
07:15:10 GMT
2015

Fri Jan 23
07:14:27 GMT
2015

Fri Jan 23
07:11:43 GMT f
2015

Fri Jan 23
07:06:14 GMT f
2015

Thu Jan 22
11:01:31 GMT

15

CASG saves a copy of all the mails received by all the users covered by your corporate account. You can restore your lost mails
from the CASG archive. This is useful if some or all of your mails are lost due to reasons like accidental deletion or mail client

crash.

To restore your mails

»  Select the mails that you want to restore.

Tip: To select all the mails at once, select the checkbox beside 'Subject'

«  Click the 'Resend email' button.

Comodo Antispam Gateway User Guide | © 2015 Comodo Security Solutions Inc. | All rights reserved 41




Comodo Antispam Gateway - User Guide

Archive

Show message

/A Reportspam( & Resend email
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g Help

' Reply | = Replyall

Show reported as spam H a Refresh

| @ Filters |

[[] Subject

[T Fwd: test

[T] Fwd: Case Study: How Epson
uses EyeCuant to Boost Conversion

Rates

[ Fwd: e o 2iisadly el ] 5

_pial

Client Meeting

| fiail rom Dagwood

From

john smith
<fiatliena@gmail com:=

john smith
=<fiatliena@gmail com:=

john smith
<fiatliena@gmail com:

dagwood bumpsted
<avantistude@gmail.com=

dagwood bumpsted

«gvantistude@gmail.com=

A confirmation dialog will be displayed.

e Click 'OK" to confirm.

Resend email(s)

To

john@docteamcasg.comaodo.od.ua

john@docteamcasg.comodo.od.ua

john@docteamcasg.comedo.od.ua

john@docteamcasg.comedo.od.ua,
fiatliena@gmail.com

john@docteamcasg.comodo.od.ua

== Are you sure you want to resend selected

@

email(s) to recipient mailbox?

A success message will be displayed.

Surcassuly sent

A copy of the email will still be retained in the archive.

Replying to Your Emails

Date (GMT +0 Size  fij

FriJan 23

6.01
074510 GMT | i
2015
FriJan 23

16.82
07:14:27 GMT | ]
2015
FriJan 23

18.14
071143 GMT | o i
2015
FriJan 23

224
07.06:14 GMT fl
2015
Thu Jan 22 175
NO131GNT 3!

e

Action

You can reply to your emails from the Archive interface of CASG, without having to open the mails in your email client.

To reply to an email

«  Choose the email to be replied from the list of emails in the archive

«  Toreply only to the sender, click 'Reply'

«  To send the reply to the sender and all the other recipients included in the 'TO" and 'CC' fields, click 'Reply all

Comodo Antispam Gateway User Guide | © 2015 Comodo Security Solutions Inc. | All rights reserved

42



COMODO

Creating Trust Online®

Archive

@] Show message /N Reportspam & Resende TS Reply | I Reply all Show
_ @ Filters

[[] Subject From To Date (G

) ) Fri Jz

john smith . )

[C] Pwd: test ) ) john@docteamcasg.comodo.od.ua 0715

=fiatliena@gmail.com= -

2015

[] Fwd: Case Study: How Epson Fri Ja

john smith
uses EyeQuant to Boost Conversion : i : john@docteamcasg.comodo.od.ua 0714
=fiatliena@gmail.com=

Rates 2015
Fri Jz
- T TEN [ I KA joh ith

I_:lFWd'”'J]IH b o _Sml ) jehn@docteameasg.comodo.odua 0711
_Aal =fiatliena@gmail.com= ~
2015

dagwood bumpsted john@docteamcasg.comodo.od.ua Ha

/] Client Meeting = , - S P8 706
=avantistude@gmail.com= fiatliena@gmail.com L

Thu

..... dagwood bumpsted
: ) £ i jehn@doctearmncasg.comodo.od.ua 11
=avantistude@gmail.com=

Ewr Armavan Chrictrmace Qala

The 'Reply' or 'Reply all' window will open.

G x

To Dagwood Bumpsted <avantistude@gmail com:, jehn@docteamecasg.comodo.od.ua, fiatliena@gmail.com
Subject RE: Client Meeting

Reply text

Original message
Hi John,
Attached is the proposal which we are going to discuss in our Saturday meeting.

Regards,
Dagwood.

You can enter your text in the upper text box and click 'Send' to reply to the mail.
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2.13  How to Manage Whitelisted Senders

CASG allows users to add senders to whitelist on per user basis. All the filtering checks for whitelisted senders are disabled.
Comodo strongly recommends to use this option only after ascertaining the authenticity of the senders. Users can add senders
to whitelist in two ways:

«  From the Quarantine interface - By requesting the administrator of your account to whitelist senders or by adding
them yourself to whitelist without approval from the administrator depending on the permissions configured. For more
details refer to the Quarantine section.

«  From the Manage whitelist senders interface — Users can add senders to whitelist manually or delete them. This
section explains this option.

To manage whitelist senders

«  Click the 'Incoming' tab on the left hand side navigation to expand and then click the ‘"Manage whitelist senders' sub
tab.

coMODO
Antispam Gateway

(3} Incoming
Juaranting
I-I C | '-_'I_
Report spam

Log search

B Manage whislist

The 'Manage whitelist senders' interface of the user will be displayed.

Manage whitelist senders € weie
2 B e ik el
£ Firers

Sandr

dEcpEheaven com
1 natienaggmail com

[1=222] Par page |18 | w

Note: The 'Add' and 'Delete’ buttons will be available only if the administrator of your account has enabled this for you. If this is
not enabled, you can just view the whitelisted senders in this interface.

Sorting the Entries

Clicking on the column heading switches the sorting of the entries based on the ascending/descending order of the entries as
per the information displayed in the column.

Using the Filter option to search senders

Click anywhere on the Filters tab to open the filters area.
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Manage whitelist senders Hialp
& st | T Delats 3 Ratresn
& Famars

Sender -

Available filter in column 1:

- Sender: Will execute a search of senders according to the text in the text box (column 3) and the condition selected in
column 2.

The following conditions are available in column 2:

«  Equals: Displays all senders that match the text entered in the text box.

»  Not Equals: Displays all senders except the one entered in the text box.

»  Contains: Displays all senders that contain the words entered in the text box.

»  Not Contains: Displays all senders that do not contain the words entered in the text box.
»  Starts With: Displays all senders that start with the words entered in the text box.

- Ends With: Displays all the senders that end with the words entered in the text box.

Click 'Apply Filter' after selecting the filters.
The application will search the respective column(s) according to the filter(s) set and display the resuilt.
Click anywhere on the Filters tab to close the filters area.

+ ¥ Refresh
Click the button to display all senders.

Note: To display all the Whitelist senders after using the filters option, you have to first click anywhere on the Filters tab to
close the filters area and then click the 'Refresh’ button.

From this interface users can:

«  Add senders to whitelist manually
«  Remove senders from whitelist

To add senders to whitelist manually

»  Click the 'Add' button at the top.

Manage whitelist senders Heip
E re + 4 Relresh
& Filters
- s s

Sander

The 'Add sender' dialog will be displayed.
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«  Enter the sender's username in the first text box and sender's email domain name in the text box after the @ symbol.

»  Click the 'Save' button. Repeat the process to add more senders to whitelist.

The list of whitelisted senders will be displayed.

Manage whitelist senders
d 2od [ Deiee
a Fiflers

| Sender

| rusti@beliove.org

] nonest@dependabie com

[1-44d])

To remove senders from whitelist

- To delete sender(s) from the whitelist, select the sender(s) from the list and click the 'Delete’ button.

0 Help

1> Refresh

Ferpape |15 =

Manage whitelist senders @ Heip
= s 3 Refresn |
£} Finers

Sender -
¥ rusi@baliove.org
noneshdependable com
[# good=oy@haaven com
fiatliena@omail com
11-aia Pai pige 1 W
»  Click 'OK' to confirm.
Remove senders
== Are you sure you want to remove selected
senders?
KB
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2.14  How to Manage Blacklisted Senders

CASG allows users to add senders to blacklist on per user basis. Please note that the messages will not be quarantined and
legitimate email sending SMTP servers will send a bounce message to the sender. Users can add senders to blacklist in two
ways:

«  From the Quarantine interface - By requesting the administrator of your account to blacklist senders or by adding
them yourself to blacklist without approval from the administrator depending on the permissions configured. For more
details refer to the Quarantine section.

«  From the Manage blacklist senders interface — Users can add senders to blacklist manually or delete them. This
section explains this option.

To manage blacklist senders

«  Click the 'Incoming' tab on the left hand side navigation to expand and then click the 'Manage blacklist senders' sub
tab.

coMODO
Antispam Gateway

ﬁ'l InComing

KManage whitelist senders

B Wanage blacklist senders

1'11 Outgoing

The 'Manage blacklist senders' interface of the user will be displayed.

Manage blacklist senders 0 s
o 21 | [ Datate 3 Retesn
£ Fitars
"] Sender
g s

1 Gl [1-242] Perpage 15 |w

Note: The 'Add' and 'Delete’ buttons will be available only if the administrator of your account has enabled this for you. If this is
not enabled, you can just view the blacklisted senders in this interface.

Sorting the Entries

Clicking on the column heading switches the sorting of the entries based on the ascending/descending order of the entries as
per the information displayed in the column.

Using the Filter option to search senders
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Click anywhere on the Filters tab to open the filters area.

Manage blacklist senders Helg
o 2os [ Dewe 3 Refesn
& Finein

K

Available filter in column 1:

- Sender: Will execute a search of senders according to the text in the text box (column 3) and the condition selected in
column 2.

The following conditions are available in column 2:
«  Equals: Displays all senders that match the text entered in the text box.
«  Not Equals: Displays all senders except the one entered in the text box.
»  Contains: Displays all senders that contain the words entered in the text box.
» Not Contains: Displays all senders that do not contain the words entered in the text box.
»  Starts With: Displays all senders that start with the words entered in the text box.
»  Ends With: Displays all the senders that end with the words entered in the text box.

Click 'Apply Filter' after selecting the filters.
The application will search the respective column(s) according to the filter(s) set and display the result.
Click anywhere on the Filters tab to close the filters area.

| + ¥ Refresh

Click the button to display all senders.

Note: To display all the Blacklist senders after using the filters option, you have to first click anywhere on the Filters tab to
close the filters area and then click the 'Refresh’ button.

From this interface users can:
«  Add senders to blacklist manually
+  Remove senders from blacklist
To add senders to blacklist manually

«  Click the 'Add' button at the top.

Manage blacklist senders Helo
E‘ Delsle it Ratash
) Fifers

Sandar

The 'Add sender' dialog will be displayed.
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Add sender

Sender:

«  Enter the sender's username in the first text box and sender's email domain name in the text box after the @ symbol.
»  Click the 'Save' button. Repeat the process to add more senders to blacklist.

The list of blacklisted senders will be displayed.

Manage blacklist senders -
= 3 Retush
) Finers

Sender
argibelisvenct com

| judas@tetrayal net
1 desilg@hell com
biulus@backslabberog

[1-dpa] Perpips (15 (W

To remove senders from blacklist

»  To delete sender(s) from the blacklist, select the sender(s) from the list and click the 'Delete’ button.

Manage blacklist senders @ veio
- o C owe) © o
a Filters

sender

V1 liangoeksvenal oom

! Judas@betrayal ned
7| gedil@hedl.com
I brutus@backstabbarorg

5

1 i [1-4r4] Perpage (15 | w

«  Click 'OK' to confirm.

Remove senders

@Are you sure you want to remove selected

senders?

Comodo Antispam Gateway User Guide | © 2015 Comodo Security Solutions Inc. | All rights reserved 49



cCOMODO

Creating Trust Online®

3 The User Interface

The Dashboard area of Comodo Antispam Gateway (CASG) allows users to have overall control of incoming mail and account
management.

The CASG web interface is divided into three main areas — Incoming, Outgoing and Account Management. Clicking on any of
these main tabs in the left hand side navigation pane will display the sub tabs available under them, which allow users to a
number of functionality such as manage quarantined emails, perform log search of incoming and outgoing emails and more The
image below shows the user interface after logging in.

y cCoOMODO
E Antispam Gateway il Ll‘dy Account
spam Gateway
@ Incoming .
Quarantine © Hew
= Quarantine
Show message m Delete Delete all a Refresh
| o Filters ‘
[ Subject From To Date (GMT+ Reason Size ﬂ Action
spam
[C] demao spam . Oct 29, 2014 External pattern 1108
e admin <admin@csg.comodo.od.ua> jonn@docteamcasg.comod - oo . bytes 7]

1y outgain
£ Quigoing (Sanesecurity. Junk.

.
1=] Account management spam
[7] demo spam . Oct 29, 20714 External pattern 1108
. admin <admin@esg.comodo.od.ua= john@docteameasg.comod o oy e 1]

(Sanesecurity. Junk.:

1 1M [1-2i2] Perpage |15 v

Having Trouble? Support is here to help. Open a Ticket at support comodo com or call 1.888.COMODO (256.2608)

Main Functional Areas

« Incoming - In this area, a user can manage his/her quarantined mails, perform log search of incoming mails, report
spam, access archived incoming mails, manage whitelist and blacklist senders. See the Incoming section for more
details.

- Outgoing - In this area, a user can perform log search of outgoing mails. See the Outgoing section for more details.

«  Account Management - In this interface, a user can change his/her CASG login password and choose to add or
remove in Recipient Whitelist and managing subscription to periodical quarantine summary reports. See the Account
Management section for more details.

«  Support - Clicking the support.comodo.com link at the bottom of interface takes you to the Comodo support web
page, an online knowledge base and support ticketing system. The fastest way to get further assistance in case you
find any problem using CASG.

3.1 Logging-in to the User Interface

Since CASG is a web application, you can login into your account using any Internet browser by entering
https:/lantispamgateway.comodo.com/user/ in the address bar of your browser.
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{C! comopo
.- Antispam Gateway

I

-
-

A Email User Interface

[USEFHEI'HE l

Password

Forgotten your password?

Login to the interface with the Username and Password that were sent to you via email after adding you as a user in the CASG

account.

In order to ensure safety, CASG will lock the user account if the login attempts fail for more than three attempts due to incorrect
Username or Password. The account will remain locked for 30 minutes and will allow you to login after it on entering the correct
Username and Password. If you want to unlock the account immediately, contact your administrator.

"E‘{ cCoOMODO
! Antispam Gateway

S

L Email User Interface

-

Your accountis locked and will be unlocked in 30
minutes.

Username
I

Password

Forgotten your password?

The time period for which the account is to be kept locked after unsuccessful login attempts can be customized by contacting the
local CASG Administrator.

In case you have forgotten your login password, click the 'Forgot your password' link to generate a new password for accessing
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CASG. Click here for more details.

3.2 The Dashboard Area

The Dashboard area of CASG has three main functional areas that can be accessed by clicking the 'Incoming’, 'Outgoing' and
'Account management' tabs on the left hand side navigation pane. Click on the 'Incoming’, ‘Outgoing' and ‘Account management'
tabs to expand or close the sections in the interface.

Note: Depending on the permission level configured for your email account by your administrator, the areas that you can
access in the interface may vary. For example, 'Quarantine’, 'Archive’, 'Report spam' under 'Incoming' tab, 'Log search' under
‘Outgoing' tab and 'Manage report subscriptions' under 'Account management' tab may not be available in the interface.

y coMODO
; Quarantine: 2 My Account
G Antispam Gateway S &' b
@ Incoming H
Quarantine © rep
Show message m Delete Delete all £ Refresh
| ° Filters
[[] Subject From To Date (GMT+ Reason Sirze | i Action
spam
demo spam Oct29, 2014 Ext | patt: 1108
- = admin <admin@csg.comodo.od.ua> Jjohn@docteameasg.comod U Lien A
@ Outgoing email 2 2:55:03PM  match bytes
- (Sanesecurity Junk :
|—:'_=-| Account management spam
[C] demo spam Oct 28, 2014 External pattern 1og
email 1 admin <admin@csg.comodo.od.ua= john@docteamcasg.comod 25446 M match s 1]
(Sanesecurity.Junk.;
1 11 [1-242] Perpage |15 v

Having Trouble? Support is here to help. Open a Ticket at support comodo.com or call 1.888.COMODO (256.2608)

« Incoming - In this area, a user can manage his/her quarantined mails, perform log search of incoming mails, report
spam, access archived incoming mails, manage whitelist and blacklist senders. See the Incoming section for more
details.

«  Outgoing - In this area, a user can perform log search of outgoing mails. See the Outgoing section for more details.

«  Account Management - In this interface, a user can change his/her CASG login password and choose to add or
remove in Recipient Whitelist and managing subscription to periodical quarantine summary reports. See the Account
Management section for more details.

- Support - Clicking the support.comodo.com link at the bottom of interface takes you to the Comodo support web
page, an online knowledge base and support ticketing system. The fastest way to get further assistance in case you
find any problem using CASG.

Various interfaces will display a help button 9 at the top right side of the interface. Clicking on this help button will take you to
the respective help page of CASG online help guide for more detailed explanation.

Click the following links for more details on the sections:
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* Incoming
- Outgoing

*  Account Management

3.2.1 Incoming

In the 'Incoming' area, a user can view, release, request release quarantined emails, perform log search of incoming mails and
add senders to whitelist and blacklist.

Note: Depending on the permission level configured for your email account by your administrator, the features that you can
access in the interface may vary. For example, Quarantine screen may not be available if this feature is not enabled for you.

cCoOMODO
: Antispam Gateway

[ I"'] INCOming

B Luarantne

Archive

Manage blackiist senders

:.fT'] Quigoing

S Account management

Click the following links for more details:
«  Quarantine
«  Archive
*  Report Spam
« Log Search
«  Manage Whitelist Senders

»  Manage Blacklist Senders

3.2.1.1 Quarantine

CASG scans all the mails received on your mail server to identify spam and malicious mails depending on the spam detection
levels set by your administrator. The mails identified as spam/malicious are moved to quarantine.

If enabled by your administrator, CASG sends notification mails to you whenever an email addressed to you is quarantined. The
notification mail will contain a link to directly open the email. You can only read the mail by clicking the link. The link will expire
after 24 hours.

An example quarantine notification mail is shown below:
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f cCOMODO
Antispam Gateway

-

New email placed in quarantine.

Sender: bluto@pirateisland.com
Date: Wed Nov 12 12:55:04 EET 2014
Subject: You've got a treasure

To see the quarantined message, click here

For help, see the User guide: hitp.//help.comodo.comffopic-157-1-294-3398-Introduction-to-Comodo-
Antispam-Gateway. htm

Having Trouble? Support is here to help. Open a Ticket at https://support.comodo.com or call
1.888.COMODO (256.2608)

Note: The administrator of your email account should have enabled this feature for you. If you are getting the quarantine
notification emails, contact your administrator.

But if you want to release the mail from quarantine or blacklist/whitelist the sender, you need to login to the CASG user interface
and open the quarantine interface.

The Quarantine interface displays a list of mails addressed to you but quarantined by CASG before delivering to your mail client.
You can view the mails and even download attachments from them, if you are sure they are safe. You can also send requests to
administrator to release quarantined emails or add the senders to either whitelist or blacklist.

Note: The administrator of your email account should have enabled this feature for you. If you are not able to view and access
your quarantined mail list, contact your administrator for enabling and accessing your quarantined emails.

Tip: You can configure CASG to send Quarantine summary reports periodically to your email. The report will contain a list of
mails identified as spam and were moved to Quarantine automatically by CASG. For more details, refer to CASG Reports -
An Overview for more details.

To open the quarantined email interface:
»  Click the 'Incoming' tab on the left hand side navigation to expand and then click the 'Quarantine' tab.

coMODOD
® Antispam Gateway

f_!] INCoAming
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«  Alternatively, click the 'Quarantine’ button at the top.

coMODOD
Antispam Gateway

2 Manage repc

) Outgoing

Cuarantine repoi

[ Account management

The quarantined email area of the user will be displayed.

Quarantine @ Hei
Show message m Delete ﬁ Delete all D Refresh

‘ o Filters |

[[] Subject From To Date (GMT Reason Size*  f Action
Oct29,  spam

[[] demo spam  admin  heDBdoceancas 2014 External pattern 1108 A

email 2 =admin@csg.comodo.od.ua= John@ 2:55:03 match bytes
P (Sanesecurity. Jur
Oct29,  spam

[C] demo spam  admin o hn@docteamcas 2014 External pattern 1108 A

email 1 <admin@csg.comodo.od.uas John@ 25446  match bytes
PM (Sanesecurity.Jur

1 i1 [1-212] Perpage |15 w

Note: Depending on the permission level configured for your email account by your administrator, the buttons in the interface
may vary. For example, 'Show message' button may not be available in the interface. The 'Request release' button may appear
as 'Release’ button in the 'More actions' drop-down button enabling you to release quarantined mail without approval from the
administrator.

The quarantined emails are displayed with eight columns providing information about the subject, the sender, details of the
recipients, the date it was sent , the reason it was quarantined, the size of the email and if there is any attachment. The last
column indicates the action taken by the user for requests to the administrator such as releasing quarantined emails or to add
the sender to blacklilst or whitelist.

Sorting the Entries

Clicking any column heading switches the sorting of the entries based on the ascending/descending order of the entries as per
the information displayed in the respective column.

Using the Filter option to search quarantined emails

«  Click anywhere on the Filters tab to open the filters area of the Quarantine interface.
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Help

Quarantine

Show message | [[J Delete Delete all ‘G Refresh ‘
Q Filters

+ Subject w | |contains w Apply filter

[] Subject From To Date (GMT Reason Size” i Action
Oct 29, spam
[C] demo spam  admin _ 2014 External pattern 1108
john@docteamcas ,, __ . . bvie ]
el R matcn oyies

email 2 <admin@csg.comodo.od.uaz

You can add more filters by clicking + for narrowing down your search.

Help

Quarantine
Show message | [[J Delete Delete all ‘G Refresh ‘

o Filters

'l' Subject w | |contains v Apply filter

Subject

& _';mm To Date (GMT Reason size | Action
[}
Date Oct29,  spam

[l di size (KB) | ohnmdocteameas 2014 Extemalpatterm 1108

email=

You can remove a filter by clicking the == icon beside it.

Available filters are:

Subject: Will execute a search of subject according to the text entered in the text box (column 3) and the condition
selected in column 2.

From: Will execute a search of senders according to the text entered in the text box (column 3) and the condition
selected in column 2.

To: Will execute a search of users according to the text entered in the text box (column 3) and the condition selected
in column 2.

When you select any one of the above options in the first drop-down, the following conditions are available:

- Contains: Displays all quarantined mails that contain the words entered in the text box
« Not Contains: Displays all quarantined emails that don't contain the words entered in the text box

Other options available in the first drop-down in the filters area:

Date: Will execute a search of mail received dates according to the date selected in the calendar box (column 3) and
the condition selected in column 2.
- Size (KB): Will execute a search of mails according to the size selected or entered in third field (column 3) and the
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condition selected in column 2.
If 'Date’ is selected, the following conditions are available:

« Equals: Displays the quarantined emails that have the same date as the selected date in the third box from the

calendar

«  Less than: Displays the quarantined emails with dates less than the selected date in the third box from the
calendar

«  Greater than: Displays the quarantined emails with dates greater than the selected date in the third box from the
calendar

If 'Size' is selected, the following conditions are available:

«  Less than: Displays the quarantined emails with size less than the selected or entered size in the third box
- Greater than: Displays the quarantined emails with size greater than the selected or entered size in the third box
«  Click 'Apply Filter' after selecting the filters.

«  Click anywhere on the Filters tab to close the filters area.

£ ¥ Refresh
«  Click the button to display all the quarantined emails.

Note: To display all the quarantined emails after using the filters option, you have to first click anywhere on the Filters tab to
close the filters area and then click the 'Refresh’ button.

Viewing Quarantined Mails

Note: The administrator of your email account should have enabled this feature for you. If this is enabled, the 'Show message'
button will be available in the interface.

The mails added to the Quarantine can be viewed in two ways:
* Inthe same CASG window
« Inanew CASG window

To view quarantined mails in the same CASG window:

« Inthe quarantined email area, select the mail that you want to view and click the 'Show Message' button.

or

«  Click on the email link in the subject column that you want to view its details.
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9 Help

E Refresh

Quarantine

(=)} Show message ﬁ Delete E Delate all
| o Filters

Apply filter

+ Subject w | [contains W
[[] Subject From To Date (GM7T + Reason Size* | il Action
. Octze, ~ °Pam
demospam  admin : External pattern 1108
. . john@docteamcas 2014 fl
email 2 <zadmin@csg.comodo.od.ua= 255:03 PM match bytes
- (Sanesecurity. Junk

spam

The selected mail will open.

58
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Guarantine f E-mail

E-mall @ He

Normal All headers

|:] Releasze Blacklist this Sender Whitelist this Sender m Delete

Subject  demo spam email 2
From admin <admin@csg.comodo.od.uas
To john@docteamcasg.comodo.od.ua
CcC

Date (GMT

+0) Wed Oct 29 14:55:03 GMT 2014

Size 1108 bytes

Actions

Plain text Html source Original View

» Diacount Hydrocodone 107325, 60 p. — £199 NEW !!'! Hydrocodone 107500
> mg (WATSON 540) - &0 pills $243, Hydrocodone 10/500 mg (WATSON 540) -
> 90 pills £339. Buy NOW!

Having Trouble? Support is here to help. Open a Ticket at support.comodo.com or call 1.888.COMODO (256.2608)

By default, the email will open in Normal view and will be displayed in Plain text, where the images, banners and links will be not
be displayed. Clicking the 'Html source' tab displays the email will all the html tags. To view images and links, click the ‘Original
View' tab. The user can also request the administrator to release the email or to add the sender to whtelist or blacklist.

Awarning will be displayed before you want to view the selected email in original.

LTI

s Are you sure you want to view this spam email?
g ! This action may harm your personal data. More
info at hitp:if'en.wikipedia.orgfwiki/Cross-

site_scripting
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«  Click 'OK" to view the email.

Check the details of the mail and ascertain whether it is a spam mail or not. You can choose to either release the email or to add
the sender to whtelist or blacklist. If there is an attachment, you can download it from this dialog.

1#) Download

Size

@ Sleep Awaymp3 6.31 MB

»  Select the attachment and click the download button.

The download dialog will open.
r ™
Opening Sleep Away.mp3 — M

You have chosen to open:
|41 Sleep Away.mp3

which is: MP3 Format Sound
from: http://5.39.28.212:8080

What should Firefox do with this file?

70 Openwith | Windows Media Player (default) -

@) i Save File

[] Do this automatically for files like this from now on.

oK ][ Cancel

You can open the attachment with an appropriate application or save to a desired location in your computer.

To view the email headers, which contain the tracking information of the mail detailing the path it has crossed before reaching
the recipient, click 'All headers' tab. The headers give full details of the sender, route, recipient, sent date, mail type and so on
and enable you to check the authenticity of the mail.

Comodo Antispam Gateway User Guide | © 2015 Comodo Security Solutions Inc. | All rights reserved 60



cCOMODO

Creating Trust Online®

Mormial All headers

1#] Download message

Received : from mail-oa0-165 goagle.com ([209.85.219 65]) -
by msrvl.dev.spamgateway.comodo.com with esmips (TLSv1.RC4-SHA128)
(Exim 4.82)
(envelope-from <fiatliena@gmail. coms=})
id 1WcAR-0000Z9-K5; Mon, 21 Apr 2014 09:38:22 +0000

Received : by mail-0a0-f65.google.com with SMTP id m1s04810660ag.0
for <multiple recipients=; Mon, 21 Apr 2014 02:38:07 0700 (PDT)

DKIM-Signature : v=1, a=rsa-sha256; c=relaxedirelaxed;
d=gmail.com; s=20120113;
h=mime-version:in-reply-to:references:date:message-idsubjectirom:to
:content-type,
bh=P+WwAQTKYGcEUHHM3gINIRHgzYvrX0ds 6ovDASDI=;
b=WhZoEdJuKBTUnVuHZGowSLD4VxLif5eEEiwUy2R5cV+cIL4JPwbpTHV+WiXAwg ]
ONMgCYKytED+P1DCrasSul pté OSurv+cfi+60rWIEBMCIE+EYuTw2gKT G50l 934 k1/9PK 3
mEEJNfuF 0ZYf7iccsa0wsiZsP6Q80g+Qj0AEr+TQb8JKTbbBdzGwIiO0M 3gkkrokMNogF
26 S+ixGgkl 004 dPIbpATBSNEZF JRGWBEV|Bold7tb0gC 116GNBIEGZIEMIAGeulLg1hd
467TNZo1nSJRpJabEyPBL2YKYKE4AWEI211 3PwlooRWNSLchrPY dvdob2Pjgzlod QFYT
CAig==

KIME-Version : 1.0

¥-Received : by 10.60.62 173 with SMTP id z18mr5409380er61.1398073086387; Mon,

21 Apr 2014 02:38:06 -0T00 (PDT)

Received : by 10.182.225 1 with HTTP; Mon, 21 Apr 2014 02:38:06 -0700 (PDT)

In-Reply-To ; <CAFuKkb4jnW_OH_6DnUJSTSTEorPXuk+zig-BedB45GEWgzhZA@mail gmail com=

References | «<53190e1678225_d3832b33815960ba@ip-10-166-191-16.mail>
<CAFuKkbdjnW_OH_6DnUJSTSTEorPXuk+zig-BedfB45GEWgzhZA@mail.gmail. com=

Date : Mon, 21 Apr 2014 15:08:06 +0530

Message-ID : <CAFuKkbSSomTKOp+FIOtgYmRS8u 1LLIUOGnKNt 1cYghTBHGMpaQ@mail gmall.coms= -

If you want to download the email, click 'Download message'. The file will be downloaded as .eml file and can be opened in any
email client.

To view a quarantined mail in a new CASG window

- Inthe quarantined email area, select the mail that you want to view, right-click on the email link in the subject column
and select to open in a new tab or new window.
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Quarantine Help
Show message m Delete Delete all E Refresh

o Filters

[] Subject* From To Date {GM Reason Size fl = Action
Oct29,  spam
demo admin _ 2014 External 110¢
Sparm em il i e e mele el e ]Uhn@dﬂdeﬂmﬁﬁsg. 25503 pattﬂln match by‘[e ﬂ
Open Link in New Tab P (Sanesecurity.
Open Link in Mew Window Oct29,  spam
[ den Open Link in New Private Window 2014 External 110¢
cteamcasyg. ]
Spam ¢ Bookmark This Link 2:54:46  pattern match byte
i - PM (Sanesecurity.J
Save Link As...,
Copy Link Location Perpage |15 |w

Search Google for "demo spam email...”

Inspect Element (O]

The browser may display a warning pop-up window notification. Click the 'Options'> then select 'Allow pop-ups for..." to allow to
open new message in a new window. Click again the 'Show message in new window'.

i@ Firefies geevested this Site f1am Spening a pap:op wind .

The details of the selected mail will be displayed in a new CASG window.
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Quarantine / E-mail

E-maill @ Hep

Normal All headers

|':| Release Blacklist this Sender Whitelist this Sender m Delete

Subject  demo spam email 2
From admin <admin@csg.comodo.od ua=
To  john@docteameasg.comodo.od.ua
cC

Date (GMT
+0)

Size 1108 bytes

Wed Oct 29 14:55:03 GMT 2014

Actions

Plain text Html source Original View

» Discount Hydrocodone 107325, 60 p. — $£19% NEW !!'! Hydrocodone 10/500
> mg (WATSCON 540) - &0 pills $249%, Hydrocodone 10/500 mg (WATSON 540) -
> 80 pills £339. Buy NOW!

Having Trouble? Support is here to help. Open a Ticket at support comodo.com or call 1.888.COMODO (256.2608)

To delete a quarantined mail

+  Select the mail that you want to delete and click the 'Delete’ button
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Quarantine ©) Heip

Show message ﬁ Delete Delete all E Refresh

‘ e Filters |

[[] Subject From To Date (GM Reason Size ﬂ Action
Oct29, spam
demao admin 2014 External 1104 ﬂ

e B pattern match  byte

spam email 2 <admin@csg.comodo.od.ua>
P (Sanesecurity..]

Oct 29, spam

dermn

An alert will be displayed to confirm the deletion. Click 'OK' to delete the selection email.

Delete emails

emails?

The selected mail will be deleted and will no longer be in the quarantined mail list.

@ Are you sure you want to delete the selected

«  To delete all the quarantined mails click the 'Delete All' button.

Quarantine © Help

Show message | [[j Delete (& Delete al £ Refresh
| o Filters |

[] Subject From To Date (GM Reason Size ﬂ Action
Dct29, spam
demo admin i 2014 External 1104
. . ohn@docteamcasg.
spam email 2 =admin@csg.comodo.od.ua= john@ 9 25503 pattern match Dyte o
PM (Sanesecurity..

0ct29,  spam

demo

An alert will be displayed to confirm the deletion. Click 'OK' to delete all quarantined emails.
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Delete emails

currently are filtered?

K =3

All the quarantined emails for the selected domain will be deleted.

@ Are you sure you want to delete all emails that

To request administrator for releasing quarantined mails:

After viewing and ensuring that the selected email is not a spam you can request your email account administrator to release the
email.

Note: Depending on the permission level configured for your email account by your administrator, the button for releasing
quarantined email will be either 'Release’ or 'Request release' in the 'More actions' drop-down button. If the interface displays
'Release’ button, you can release the selected email from the list without approval from your administrator.

«  Select the mail that you want to be released and click 'More actions' > 'Release'
Quarantine Help
Show message ﬁ Delete Delete all G Refresh

0 Filters

Blacklist this Sender

[[] Subject* From To ason Size [ = Action
Whitelist this Sender
AT
demo admin : 2014 External 1104
. : hn@doct i
spam email 2 <admin@csg.comodo.od.ua> John@docteameasg. 5 5503 pattern match Dyte o
PM (Sanesecurity.
Oct29, spam
[C] demao admin . 2014 External 1104
. : ochn@docteamcasg.
spam email 1 <admin@csg.comodo.od.ua= john@ 9 25446 pattern match  byte o
PM (Sanesecurity.
1 i [1-212] Perpage |15 w

An email notification will be sent to your administrator for your request and you also will also receive the request email. This
request will also be displayed in the 'Action’ column of the users' Quarantined interface. If the administrator accepts the request,
the user will receive the email and if it is rejected, 'Release ' icon in the Action column will no be longer be displayed.

To request administrator for adding senders to blacklist
To avoid receiving spam emails, you can request the administrator to add the senders of these emails to blacklist.

Note: Depending on the permission level configured for your email account by your administrator, the button for adding
senders to blacklist will be 'Blacklist this Sender' or 'Request blacklist' in the 'More actions' drop-down button. If the interface
displays 'Blacklist this Sender' button, you can add the sender to blacklist without approval from your administrator.

«  Select the mail that you want its sender to be added to blacklist and and click 'More actions' > 'Blacklist this Sender'
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Quarantine Help
Show message  [[J Delete [ Delete al ‘G Refresh ‘
Releaze

o
[] Subject* From To ason Size [l = Action
Whitelist this Sender
—-am
demao admin ndocteamcas 2014 External 1104 A
spam email 2 <admin@csg.comodo.od.ua= lohn@ 9 25503 pattern match  Dyte
PM (Sanesecurity.J

Oct29,  spam

[C] demo admin hn@docteameas 2014 External 1104 i
gpam email 1 <admin@csg.comodo.od.uas John@ 9 25446 pattern match  byte
PM (Sanesecurity.J

1 M [1-2/2] Per page |15 w

An email notification will be sent to your administrator for your request and you also will also receive the request email. This
request will also be displayed in the 'Action’ column of the users' Quarantined interface. If the administrator accepts the request,
the sender will be added to blacklist and the user will no longer receive any mail from that sender. If the request is rejected,
‘Blacklist this Sender" icon in the Action column will no be longer be displayed.

Senders added to blacklist will be displayed in the Manage blacklist senders interface. Refer to the section Managing
Blacklisted Senders for more details.

To request administrator for adding senders to whitelist:

If the incoming mails of authenticated senders are quarantined, you can request the administrator to add these senders to
whitelilst.

Note: Depending on the permission level configured for your email account by your administrator, the button for adding
senders to whitelist will be 'Whitelist this Sender' or 'Request whitelist' in the 'More actions' drop-down button. If the interface
displays "Whitelist this Sender' button, you can add the sender to whitelist without approval from your administrator.

«  Select the malil that you want its sender to be added to whitelist and click 'More actions' > 'Whitelist this Sender'
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Quarantine

Show message m Delete ﬁ Delete all

| o Filters

Release

Blacklist this Sender

cCOMODO

Creating Trust Online®

9 Help

G Refresh ‘

[[] Subject” From To ason Size fjl | Action
A
demo admin : 2014 External 1104
. : hn@doct !
spam email 2 <admin@csg.comodo.od.ua= John@docteameasg 25503  pattern match byte B
P (Sanesecurity.
Dct29,  spam
[C] demao admin . 2014 External 1104
] . hni@doct L
spam email 1 <admin@csg.comodo.od.ua> John@AOCteameasy. 5 5445 pattern match Dyte L
P (Sanesecurity.
1 i1 [1-2/2] Perpage |15 W

An email notification will be sent to your administrator for your request and you also will also receive the request email. This
request will also be displayed in the 'Action’ column of the users' Quarantined interface. If the administrator accepts the request,
the sender will be added to whitelist and the mails from them will no longer be quarantined. If the request is rejected, 'Whitelist
this Sender" icon in the Action column will no be longer be displayed.

Senders added to whitelist will be displayed in the 'Manage whitelist senders' interface. Refer to the section Managing
Whitelisted Senders for more details.

3.2.1.2 Managing Archived Mails

CASG is capable of storing a copy of all incoming mails for all users belonging to an account. The Archive interface allows you
to view the messages, report spam and restore emails and reply to them.

Note: The administrator of your email account should have enabled this feature for you. If this is enabled, the 'Archive' sub tab
will be available in the left hand side navigation area under the 'Incoming' tab.

To open the Archive interface

«  Select the 'Incoming' tab from the left hand side navigation, then click the 'Archive' tab.

cCoOMODD
Antispam Gateway

|i| Incoming
Quarantine
B Archinve
Log seanch
Manage whitelist senders

|l| Outgoing

9 Account management
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Your Email Archive interface will open with a list if emails received for your email address.
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Archive Help
Show message /N Reportspam ‘& Resendemail 5 Reply | ¥ Replyall [T] Show reported as spam || D Refresh
6 Filters
[[] Subject From To Date (GMT +0) Size n Action

Tue Jan 20
) dagwood bumpsted _
[Z] mail from Dagwood ) : john@docteamcasg. 06:49:58 GMT 764 KB fl
<avantistude@gmail.com=
2015
_ dagwood bumpsted _ T o X
mail from Dagwood : : john@docteamcasg. 06:49:58 GMT 414 KB ]
<avantistude@gmail.com:
2015
. ) Thu Oct 30
Quarantine Repart for admin@antispamgateway.c john@docteamcasg. 04:00:51 GMT 2322 KB il

john@docteamcasg.comodo.od.ua

From this interface you can:
«  View mails
*  Report mails as spam
*  Resend mails
«  Send Replies to mails

Sorting the Entries

Clicking any column heading switches the sorting of the entries based on the ascending/descending order of the entries as per

the information displayed in the respective column.

Using the Filter option to search archived emails

«  Click anywhere on the 'Filters' tab to open the filters area.

Archive Help
Show message /M Reportspam & Resendemail 757 Reply  ¥=5 Reply all [F] 8how reported as spam || D Refresh ‘
@ Filters
+ Subject w | contains v Apply filter
[[] Subject From To Date (GMT +0) Size ﬁ] Action

You can add more filters by clicking + for narrowing down your search.

68
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Archive Help
Show message & Report spam = Resend email = Reply | = Reply all [C] Show reported as spam ||B Refresh
@ Filters
+ Subject v  |contains v Apply filter
== From + | contains v
== Date v | equals v [
= |Subject v | |contains v

| Subject 5
| |
O g :mm I From To Date (GMT +0) Size i Action
| To |
Date R . Tue Jan 20
M Size (KB) - ; (
| Aftachments |

You can remove a filter by clicking the ™= icon beside it.

Available filters are:

»  Subject: Will execute a search of subject according to the text entered in the text box (column 3) and the condition
selected in column 2.

«  From: Will execute a search of senders according to the text entered in the text box (column 3) and the condition
selected in column 2.

- To: Will execute a search of users according to the text entered in the text box (column 3) and the condition selected
in column 2.

When you select any one of the above options in the first drop-down, the following conditions are available:

- Contains: Displays all archived mails that contain the words entered in the text box
- Not Contains: Displays all archived emails that don't contain the words entered in the text box
Other options available in the first drop-down in the filters area:

«  Date: Will execute a search of mail received dates according to the date selected in the calendar box (column 3) and
the condition selected in column 2.

»  Size (KB): Will execute a search of mails according to the size selected or entered in third field (column 3) and the
condition selected in column 2.

- Attachments: Will execute a search of mails according to the checkbox status (column 3) whether enabled or
disabled. If enabled, all archived mails with attachments will be displayed.

- Marked as retained: Will execute a search of mails according to the checkbox status (column 3) whether enabled or
disabled. If enabled, all archived mails that are marked as retained will be displayed.

If 'Date’ is selected, the following conditions are available:

«  Equals: Displays the archived emails that have the same date as the selected date in the third box from the
calendar

«  Less than: Displays the archived emails with dates less than the selected date in the third box from the calendar

- Greater than: Displays the archived emails with dates greater than the selected date in the third box from the
calendar

If 'Size' is selected, the following conditions are available:

«  Less than: Displays the archived emails with size less than the selected or entered size in the third box
»  Greater than: Displays the archived emails with size greater than the selected or entered size in the third box

»  Click 'Apply Filter' after selecting the filters.
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The application will search the respective column(s) according to the filter(s) set and display the result.

«  Click anywhere on the Filters tab to close the filters area.

The emails by accidentally have sent to spam might be displaced to Archive. Click the 'Show reported as spam' button to view all
reported as spam emails. For data-intensive you can use Filters criteria.

£ ¥ Refresh
«  Click the button to display all the archived emails.

Note: To display all the archived emails after using the filters option, you have to first click anywhere on the Filters tab to close
the filters area and then click the 'Refresh’ button.

Viewing Archived Mails

You can view the mails, download attachments, reply to them and more from the 'Archive' interface.

To view an archived mail
»  Select the mail that you want to view and click the 'Show Message' button.

or
«  Click on the email link in the subject column that you want to view.

Archive Help
Show message & Report spam f;' Resend email 15 Reply 5 Reply all [[] Show reported as spam || G Refresh
9 Filters
] Subject From To Date (GMT +0) Size ﬁ] Action

Tue Jan 20
] dagwood bumpsted )
[Z] mail from Dagwood : : john@docteamcasg. 06:49:58 GMT 7.64 KB fil
<avantistude@gmail.com:=
2015
_ dagwood bumpsted _ T o o8
mail from Dagwood : . john@docteamcasg. 06:49:58 GMT 4.14KB i
<avantistude@gmail.com=
2015
— ) Thu Oct 30
Quarantine Report for admin@antispamgateway.c john@docteamcasg. 04:00:51 GMT 23.22 KB il

john@docteamcasg.comodo.od.ua

The selected email will be displayed.
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Tip: You can also choose to open the mail on a different browser tab or browser window. Right-click on the email link in the
subject column and select to open it in a new tab or new window.

SUject rrom i

Thu J:
d d bumpsted
Ow R ) john@docteameasg.comodo.od.ua  11:01:3
Open Link in New Tab floam:- CMT -
Open Link in New Window Thu
= FT Open Link in New Private Window ) john@docteameasg.comodo.od.ua 09
Upto 3 fahoo.co.in= -
Bookmark This Link e
Share This Link
Cards Save Link As... A it
Copy Link Location
F Search Geogle for "Mail from Dagwe..”
Inspect Element ()

The browser may display a warning pop-up window natification. Click the 'Options'> then select 'Allow pop-ups for..." to allow to
open new message in a new window. Click again 'Show message in new window'.

g Firefeu grevented this site Trom pfing a pop-op rend o, Diptiens =

The selected mail will be displayed in a new CASG window.

Archive / Archive mail
Archive mail © Hen

Normal | All headers
/N Reportspam (& Resendemail i Reply i Replyall

Subject  Mail from Dagwood
From dagwood bumpsted <avantistude@gmail.coms=

To  jehn@docteameasg.comodo.od.ua

CC
Date (BMT 5150122 110131
+0)
Size 3.J75KB
Actions
Plain text | Html source | Criginal View
Hai John, 5

As discussed over phone, I would like to confirm cur meeting on Saturday. I
will be at wour office at eight 0' clock in the morning.

Regards,
Dagwood.

By default, the email will open in 'Normal' view and will be displayed in Plain text, where the images, banners and links will not
be displayed.

«  Toview images and links, click the 'Original View' tab.
«  To view the mail with all HTML tags, click the 'Html source' tab.
- To view the email headers, which contain the tracking information of the mail detailing the path it has crossed before
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reaching the recipient, click 'All headers' tab in the upper pane. The headers give full details of the sender, route,
recipient, sent date, mail type and so on.

«  To download attachments, select the attachment from the lower pane and click 'Download'

Plain text | Himl source Original View

Hi John,

Lttached is the proposal which we are going to discuss in cur Saturday
meeting.

Regards,
Dagwood.

1+ Download

Hame Size

john_proposal.doc 18.47 KB

The buttons at the upper pane enable you to:
»  Report the mail as spam;
»  Resend the mail to your mail box; and
*  Reply to the mails.

Report the mail as spam

If the mail appears to be a spam after reading it and viewing the details, you can choose to report it as a spam to CASG for
quarantining such mails in future.

- Toreport the mail as a spam click the 'Report spam'’ button at the top left of the upper pane. A confirmation dialog will
appear.

Hormal All headers

/1 Report spam f;" Resend email i Reply &5 Replyall

éubje Mail frem Dagwood
Fro dagwood bumpsted <avantistude@gmail.com=
To | john@docteameasg.comodo.od.ua
cC

Date (GMT
ate BN =.01.99 11.01-31

Report as spam

#F =% Are you sure you want to mark the selected
@ emails as spam?

»  Click 'OK"in the confirmation dialog.

Tip: You can report several mails as spam at once from the Archive Mall interface. Refer to the explanation under Reporting
mails as spam for more details.
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Resend the mail to your mailbox

CASG allows you to restore your mails from its archive, in case the original mail was lost. You can forward the currently viewed
mail your mail box.

Tip: You can resend several mails from the archive to your mailbox at once from the Archive Mail interface. Refer to the
explanation under Resending mails to your mail box for more details.

«  Toresend the mail click the 'Resend email' button from the upper pane. A confirmation dialog will appear.

Normal All headers

/M Reportspam (& Resend email )= Reply = 5§ Replyall

Subject  Mail from Dagwy
From  dagwood bumgsted <avantistude@gmail com:=

To  john@docteaghcasg.comodo.od.ua

CC

Date (GMT Resend email(s)

+{)

=% Are you sure you want to resend selected
@ email(s) to recipient mailbox?

«  Click 'OK"in the confirmation dialog.
The mail will be sent only to your mail box and NOT to other recipients in the TO or CC/BCC fields.
Reply to the mail
You can send reply to the currently viewed mail from the CASG interface, without having to open the mail from your mail client.

- Toreply only to the sender, click the 'Reply' button from the upper pane
< Toreply to all in the mailing list, including the recipients in the CC list, click the 'Reply all' from the upper pane
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Hormal | All headers

M\ Reportspam & Resendemdl | ¥ Reply | I Replyall

Subject  Mail from Dagwood

From dagwood bumpsted <avantistude@fmail.com:=

To  john@docteameasg.comogkod.ua

Reply all

To Dagwooed Bumpsted <avantistude@gmail come, jehn@docteameasg.comodo.od.ua
Subject RE: Mail from Dagwood

Reply text

Original message
Hai John,

As discussed aver phone, | would like to confirrn our meeting on Saturday. | will be at your office at eight ' clock in the morning

Reqards,
Dagwaod.

1

You can enter your text in the upper text box and click 'Send' to reply to the mail.

Reporting mails as spam

You can report the mails that you consider as spam from the Archive interface. CASG will process those mails and if found to be
spam, will move them to quarantine.

To report mails as spam

«  Select the mails that you want to report as spam and click 'Report spam'.
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Archive

‘% Resendemail ¥ Reply = Reply all [ Show

@ Show message

.& Report spam

_ @ Filters

[[] Subject From To Date {C
Fri Jz
joh ith
[T Fwd: test fenn _Sml . jehn@docteamcasg.comodo.od.ua 07:15
<fiatliena@gmail.com:= N
2015
wd. Case Study: How Epson b smith Frida
Uses EyeQuant to Boost Conversion ) ; jehn@docteamcasg.comodo.od.ua 0714
1atliena@gmail.com:= i
Rates 2015
S 5 Fri Jai
- el y jehn@docteamcasg.comodo.od.ua  07:11
H i
2015

: Fri Jz
ohn@docteamcasg.comodo.od.ua,
i L

1 Client Mesting

Report as spam

= Are you sure you want to mark the selected
L@ emails as spam?

KN =3

«  Click 'OK"in the confirmation dialog.

‘Spam reportad suctesstully

Viewing the Mails You Reported as Spam

You can identify the emails that you reported as spam in the past from the 'Archive' interface by clicking the 'Show reported as
spam checkbox' at the top right. The mails will be identified by the yellow icon % in the Action column in the right.
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Archive €
Show message & Report spam = Resend email i Reply i Replyall Scow reported asspamlm Refresh ‘

| @ Filters

[] Subject

[T Fwd: test

Fwd: Case Study: How Epson
uses EyeCluant to Boost Conversion
Rates

[ Fwd; et o ity ol e
S

[T] client Meeting

Mail from Dagwood

From

jehn smith
<fiatliena@gmail.com=

john smith
=fiatliena@gmail.com=>

jehn smith
<fiatliena@gmail.com=

dagwood bumpsted
zavantistude@gmail.com:

dagwood bumpsted

=gvantistude@gmail.com:

Resending mails to your mail box

COMODO

Creating Trust Online®

Help

To

john@decteameasg.comodo.od.ua

john@docteamcasg.comodo.od.ua

john@decteameasg.comodo.od.ua

john@docteameasg.comodo.od.ua,
fiatliena@gmail.com

john@docteameasg.comodo.od.ua

Date (GMT i

Fri Jan 23
07:15:10 GMT
2015

Fri Jan 23
07:14:27 GMT
2015

Fri Jan 23
07:11:43 GMT f
2015

Fri Jan 23
07:06:14 GMT f
2015

Thu Jan 22
11:01:31 GMT

15

Action

CASG saves a copy of all the mails received by all the users covered by your corporate account. You can restore your lost mails
from the CASG archive. This is useful if some or all of your mails are lost due to reasons like accidental deletion or mail client

crash.

To restore your mails

»  Select the mails that you want to restore.

Tip: To select all the mails at once, select the checkbox beside 'Subject'

»  Click the 'Resend email' button.
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Archive

Show message

/A Reportspam( & Resend email

COMODO
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g Help

' Reply | = Replyall

Show reported as spam H a Refresh

| @ Filters |

[[] Subject

[T Fwd: test

[T] Fwd: Case Study: How Epson
uses EyeCuant to Boost Conversion

Rates

[ Fwd: e o 2iisadly el ] 5

_pial

Client Meeting

| fiail rom Dagwood

From

john smith
<fiatliena@gmail com:=

john smith
=<fiatliena@gmail com:=

john smith
<fiatliena@gmail com:

dagwood bumpsted
<avantistude@gmail.com=

dagwood bumpsted

«gvantistude@gmail.com=

A confirmation dialog will be displayed.

e Click 'OK" to confirm.

Resend email(s)

To

john@docteamcasg.comaodo.od.ua

john@docteamcasg.comodo.od.ua

john@docteamcasg.comedo.od.ua

john@docteamcasg.comedo.od.ua,
fiatliena@gmail.com

john@docteamcasg.comodo.od.ua

== Are you sure you want to resend selected

@

email(s) to recipient mailbox?

A success message will be displayed.

Surcassuly sent

A copy of the email will still be retained in the archive.

Replying to Your Emails

Date (GMT +0 Size  fij

FriJan 23

6.01
074510 GMT | i
2015
FriJan 23

16.82
07:14:27 GMT | ]
2015
FriJan 23

18.14
071143 GMT | o i
2015
FriJan 23

224
07.06:14 GMT fl
2015
Thu Jan 22 175
NO131GNT 3!

e

Action

You can reply to your emails from the Archive interface of CASG, without having to open the mails in your email client.

To reply to an email

«  Choose the email to be replied from the list of emails in the archive

«  Toreply only to the sender, click 'Reply'

«  To send the reply to the sender and all the other recipients included in the 'TO" and 'CC' fields, click 'Reply all
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Archive

@] Show message /N Reportspam & Resende TS Reply | I Reply all Show
_ @ Filters

[[] Subject From To Date (G

) ) Fri Jz

john smith . )

[C] Pwd: test ) ) john@docteamcasg.comodo.od.ua 0715

=fiatliena@gmail.com= -

2015

[] Fwd: Case Study: How Epson Fri Ja

john smith
uses EyeQuant to Boost Conversion : i : john@docteamcasg.comodo.od.ua 0714
=fiatliena@gmail.com=

Rates 2015
Fri Jz
- T TEN [ I KA joh ith

I_:lFWd'”'J]IH b o _Sml ) jehn@docteameasg.comodo.odua 0711
_Aal =fiatliena@gmail.com= ~
2015

dagwood bumpsted john@docteamcasg.comodo.od.ua Ha

/] Client Meeting = , - S P8 706
=avantistude@gmail.com= fiatliena@gmail.com L

Thu

..... dagwood bumpsted
: ) £ i jehn@doctearmncasg.comodo.od.ua 11
=avantistude@gmail.com=

Ewr Armavan Chrictrmace Qala

The 'Reply' or 'Reply all' window will open.

G x

To Dagwood Bumpsted <avantistude@gmail com:, jehn@docteamecasg.comodo.od.ua, fiatliena@gmail.com
Subject RE: Client Meeting

Reply text

Original message
Hi John,
Attached is the proposal which we are going to discuss in our Saturday meeting.

Regards,
Dagwood.

You can enter your text in the upper text box and click 'Send' to reply to the mail.
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3.2.1.3 Report Spam

The Report Spam feature allows you to report suspected junk emails that have by-passed existing filters and landed in your
inbox. CASG will analyze reported mails and, if found to be spam, will update its filters to quarantine similar mails in future. You
can upload spam mails locally saved in your system into this area.

Note: The administrator of your email account should have enabled this feature for you. If this is enabled, the 'Report spam'’
sub tab will be available in the left hand side navigation area under the 'Incoming’ tab.

To report a spam mail
«  Click the 'Incoming' tab on the left hand side navigation to expand and then click the 'Report spam' tab.

y cCoOMODOD
® Antispam Gateway

4y incoming
Cuarantine
Archive

B Repon spam

Manage blacklist se

|i‘;- Culgoing

E! Account management

The Report Spam interface will be displayed.

Report spam © Hep

Upload .eml format files only (max. size - 9 Mb)

1) Upload

«  Click the 'Upload' button.

Note: The files should be email format (with .eml extension) and its size should not exceed 9 MB. The following error message
will be displayed if any of the above is not complied with.

Perhaps the body of the file is damaged o i Is nat * emi farmat or it size greater than OMD (outgoing_users.csv) [x]

- Navigate to the location where the suspected email(s) is/are stored in your system. Select the mail that you want to
report as spam and click 'Open’. The maximum size of the file that can be uploaded is 9 MB.
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=i tangel Beauty Clinic

59 Apply, Get Real Quotes For Top Plans. Go With The Best Offer

54 Europe Lotkery - Yoo waon £500,000

ES MY CaNADTAN PHARMACY

54 Your Email Id has won 1,000,000,00 GEP in the British Microsoft Inc,

File name: I.ﬁ.ngel Beauty Clinic j Open I
Files of tpe: I,-‘.‘-.II Files [*.%] j Cancel |
g

The mail will be processed for uploading and success message will be displayed after the process is completed.

Report spam @ Heip

Spam reported successfully |

Upload .eml format files only (max. size - 9 Mb)

3.2.1.4 Log Search

The Log Search option in CASG allows you to search for email messages based on the parameters entered or selected in the
interface.

Note: The administrator of your email account should have enabled this feature for you. If this is enabled, the 'Log search' sub
tab will be available in the left hand side navigation area under the 'Incoming’ tab.

To perform a log search of your incoming emails

«  Click the 'Incoming' tab on the left hand side navigation to expand and then click the ‘Log search' sub tab.
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Antispam Gateway

(¥} Incoming

Juaranting

Manage blac

(1) Outgoing

El Account management

The 'Log search (incoming)' interface of the user will be displayed.

Log search (incoming) O Hen

Date range: |2014-10-28 FM 03:08:08 [i] -|2014-10-29 PM 03:08:06  [:=

Message ID:

Sender.
Recipient: [john @docteamcasg.comodo.od.ua

Sender IR

Sender host:

Include results from the last minutes: D

earch

[p]

- Date range: Select the date range for which you want to search the log file.
«  Message ID: - Enter a unique message identifier (optional )

< Sender: Enter the sender email address in this field.

« Recipient: The currently logged in user name will be displayed in this field.
«  Sender IP: Enter the IP address of the sender.

»  Sender Host: Enter the sender host name.

« Include results from the last minutes: If selected, CASG will include messages that are currently being migrated
from the filtering server to the logging server in the search results.

The optian “Indude resulls from the last minutes™will slow down the search result retrieval u

»  Click the 'Search' button.

CASG will search for the entered terms and display the results.
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Date and time~ Host (Exim idj- = Sender hostnan Sender Recipient Subject Classification
Rejected
2014-10-29 mxsrv3.spamgat mxsrv3.spamgat ) : demo spam
, admin@csg.cor john ) External pattern
14:53:43 1Xjud0-0006Ve-A 178.33.199.69 @cs0 J email 1 P
match
mxsrv2.spamgat Rejected
2014-10-29 ) j
1XjULT- MXSTV2.spamgat demo@csg.com john Spam email 1 Rejected h'.'l" .
14:45:07 178.33.199.66 relay restriction
0001RZ-B8 . .
for this recipient
mxsrvl.spamagat Rejected
2014-10-29 i j
s TXJUUX- mxsrv2.spamgat demo@csg.com john Spam email 2 Rejected h]r .
14:44:59 . 178.33.199.66 relay restriction
0006MV-Bj - - r
for this recipient
1 1 [1-373] Perpage |15 W
Sorting the Entries

Clicking any column heading switches the sorting of the entries based on the ascending/descending order of the entries as per
the information displayed in the respective column.

3.2.1.5 Managing Whitelist Senders

CASG allows users to add senders to whitelist on per user basis. All the filtering checks for whitelisted senders are disabled.
Comodo strongly recommends to use this option only after ascertaining the authenticity of the senders. Users can add senders
to whitelist in two ways:

- From the Quarantine interface - By requesting the administrator of your account to whitelist senders or by adding
them yourself to whitelist without approval from the administrator depending on the permissions configured. For more
details refer to the Quarantine section.

«  From the Manage whitelist senders interface — Users can add senders to whitelist manually or delete them. This
section explains this option.

To manage whitelist senders

«  Click the 'Incoming' tab on the left hand side navigation to expand and then click the 'Manage whitelist senders' sub
tab.
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Juarantine
Archive
Report spam
Log search
B Manage whitelist senders
Manage blacklist senders
Iy ouigoin q

|_1I:| Account man

The 'Manage whitelist senders' interface of the user will be displayed.

Manage whitelist senders

E} Halp
e sod [ Delete £ Fufesh
£ Fites
Samdar

oodEoyiheaven com

1 natiienag@gmail com

Note: The 'Add' and 'Delete’ buttons will be available only if the administrator of your account has enabled this for you. If this is
not enabled, you can just view the whitelisted senders in this interface.

Sorting the Entries

Clicking on the column heading switches the sorting of the entries based on the ascending/descending order of the entries as
per the information displayed in the column.

Using the Filter option to search senders

Click anywhere on the Filters tab to open the filters area.

Manage whitelist senders @ Hap
+ Ada ﬁ Crwinle 't:l' Rifresh |
& Faters

Sender

Available filter in column 1:

- Sender: Will execute a search of senders according to the text in the text box (column 3) and the condition selected in
column 2.

The following conditions are available in column 2:

»  Equals: Displays all senders that match the text entered in the text box.
»  Not Equals: Displays all senders except the one entered in the text box.

Comodo Antispam Gateway User Guide | © 2015 Comodo Security Solutions Inc. | All rights reserved 83



cCOMODO

Creating Trust Online®

»  Contains: Displays all senders that contain the words entered in the text box.

»  Not Contains: Displays all senders that do not contain the words entered in the text box.
- Starts With: Displays all senders that start with the words entered in the text box.

- Ends With: Displays all the senders that end with the words entered in the text box.

«  Click 'Apply Filter' after selecting the filters.
The application will search the respective column(s) according to the filter(s) set and display the result.

»  Click anywhere on the Filters tab to close the filters area.

3 Refresh

«  Click the button to display all senders.

Note: To display all the Whitelist senders after using the filters option, you have to first click anywhere on the Filters tab to
close the filters area and then click the 'Refresh’ button.

From this interface users can:

«  Add senders to whitelist manually

«  Remove senders from whitelist
To add senders to whitelist manually

«  Click the 'Add' button at the top.

Manage whitelist senders @ Haip

ﬁ Oislsha 3 Rehesh

& Fiters
+ w | DarREnG w Apply filter

Sandar

The 'Add sender' dialog will be displayed.

Add sender

Sender:

- Enter the sender's username in the first text box and sender's email domain name in the text box after the @ symbol.
»  Click the 'Save' button. Repeat the process to add more senders to whitelist.

The list of whitelisted senders will be displayed.

Comodo Antispam Gateway User Guide | © 2015 Comodo Security Solutions Inc. | All rights reserved 84



Creating Trust Online®

Comodo Antispam Gateway - Us_g_[____Guide""f __ COMODO

Manage whitelist senders D Heln
e sed [ Delete i Retosh
g Filers

Sender -
1 hone: shf:dependable com
| fatienag@gmail oom
[1-474] Ferpape (15w

To remove senders from whitelist

»  To delete sender(s) from the whitelist, select the sender(s) from the list and click the 'Delete’ button.

Manage whitelist senders 2
3 am 3 Relresn
£ Fine

sander i

¥ rusi@baliove.org

Grdependable com
¥ goodopg@haaven com
Ratfienaggmail com

LTy Parpige 15 | w

«  Click 'OK' to confirm.

Remove senders

@Are you sure you want to remove selected

senders?

3.2.1.6 Managing Blacklist Senders

CASG allows users to add senders to blacklist on per user basis. Please note that the messages will not be quarantined and
legitimate email sending SMTP servers will send a bounce message to the sender. Users can add senders to blacklist in two
ways:

«  From the Quarantine interface - By requesting the administrator of your account to blacklist senders or by adding
them yourself to blacklist without approval from the administrator depending on the permissions configured. For more
details refer to the Quarantine section.

«  From the Manage blacklist senders interface — Users can add senders to blacklist manually or delete them. This
section explains this option.

To manage blacklist senders

«  Click the 'Incoming' tab on the left hand side navigation to expand and then click the '"Manage blacklist senders' sub
tab.
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3} Incoming

Cuarantne

Klanage whitelist senders

B Manage blackist senders

ﬂl Outgoing

The 'Manage blacklist senders' interface of the user will be displayed.

Manage blacklist senders @ ren
e saa | [ ostet 3 menesn
© rirers
[F] Sender

Parpage 16 | W

Note: The 'Add' and 'Delete’ buttons will be available only if the administrator of your account has enabled this for you. If this is
not enabled, you can just view the blacklisted senders in this interface.

Sorting the Entries

Clicking on the column heading switches the sorting of the entries based on the ascending/descending order of the entries as
per the information displayed in the column.

Using the Filter option to search senders

Click anywhere on the Filters tab to open the filters area.

Manage blacklist senders @ ren
o 230 [ Delee £ Rehesn |
& Fineis

Kt

Available filter in column 1:

- Sender: Will execute a search of senders according to the text in the text box (column 3) and the condition selected in
column 2.

The following conditions are available in column 2:

- Equals: Displays all senders that match the text entered in the text box.
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»  Not Equals: Displays all senders except the one entered in the text box.
- Contains: Displays all senders that contain the words entered in the text box.
- Not Contains: Displays all senders that do not contain the words entered in the text box.
- Starts With: Displays all senders that start with the words entered in the text box.
- Ends With: Displays all the senders that end with the words entered in the text box.
»  Click 'Apply Filter' after selecting the filters.

The application will search the respective column(s) according to the filter(s) set and display the result.

»  Click anywhere on the Filters tab to close the filters area.

3 Refresh

«  Click the button to display all senders.

Note: To display all the Blacklist senders after using the filters option, you have to first click anywhere on the Filters tab to
close the filters area and then click the ‘Refresh’ button.

From this interface users can:
« Add senders to blacklist manually
«  Remove senders from blacklist
To add senders to blacklist manually

»  Click the 'Add' button at the top.

Manage blacklist senders ) Help
E| Delete 2 Refesh
) Fitiers

Sandar

The 'Add sender' dialog will be displayed.

Add sender

- Enter the sender's username in the first text box and sender's email domain name in the text box after the @ symbol.

»  Click the 'Save' button. Repeat the process to add more senders to blacklist.

The list of blacklisted senders will be displayed.
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Manage blacklist senders @ 1w
o asa [ oo i Rstresh
© Finers

Sender

| nargbelievenct com

| judas@t=erayalnet

[1-4vd] Pirpags |15 | v

To remove senders from blacklist

»  To delete sender(s) from the blacklist, select the sender(s) from the list and click the 'Delete’ button.

Manage blacklist senders © Heip
o 100 C oee) 2 oo
a Filters

Sender

7| liang@oekesenoloom

Judas@batrayal ned

¥ devil@hedl com

1 [ fr-4i%] Perpage (15 | w

»  Click 'OK' to confirm.

Remove senders

@Are you sure you want to remove selected

senders?

3.2.2 Outgoing

The Log Search feature in Outgoing section allows you to search for sent email messages such as mails with virus, spam mails
or as per the filter criteria selected in the 'Classification’ drop-down. You can also run a search based on other filters such as
date range, recipient, sender IP and host.

Note: The administrator of your email account should have enabled this feature for you. If this is enabled, the 'Log search' sub
tab will be available in the left hand side navigation area under the 'Outgoing’ tab.
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Click the following link for more details:

+ Log search

3.2.2.1 Log search

In the outgoing Log Search interface, you can search sent email messages based on filters such as date range, recipient email
address, sender IP and classification.

Note: The administrator of your email account should have enabled this feature for you. If this is enabled, the 'Log search' sub
tab will be available in the left hand side navigation area under the 'Outgoing’ tab.

To perform a log search of your outgoing emails
«  Click the 'Outgoing' tab on the left hand side navigation to expand and then click the ‘Log search’ sub tab.

CoOMODO
Antlspam Gateway

3 mcomin 4 LG.
'll Outgoing

B | ogs=sarch

The 'Log Search (Outgoing)' interface of the user will be displayed.
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Date range: |2014-10-28 PM 03:14:14  [£]]|-|2014-10-20 PM 03:14:14  []

Message |D:
Sender |john [@docteamcasg.comodo.od.ua
User. @docteamcasg.comodo.od.ua

Recipient:

Sender IP.

Sender host:
Classification: |All w

Include results from the last minutes: [

= R

+ Date range: Select the date range for which you want to search for the sent mails.

+ Message ID: - Enter a unique message identifier (optional )

+ Sender: The currently logged in user name will be displayed in this field.

+ User: Enter the username of the outgoing email address for in this field (for example, 'testuserl@example.com’).

+ Recipient: Enter the email address of the recipient (for example, 'testuserl@domain.in’) that you want to search for
sent mails.

+ Sender IP: Enter the IP address of the sender.
+ Sender host: Enter the sender host name.
+ Classification: Select the type of email that you want to search from the drop-down options.

+ Include results from the last minutes: If selected, CASG will include messages that are currently being migrated
from the filtering server to the logging server in the search results.

The aptian “Indude resulls from the last minutes™ will slow down the search result retrieval u

»  Click the 'Search' button.
CASG will search for the sent mails based on the filters entered and / or selected and display the results.

Date and tinie Host (Eximid) Sender hosin, User Sender Recipient Subject Classification
mxsrv3.spamg . .

2014-10-29 . mail2.comedo. . outgoing Accepted
1XjUYSs- john john@doctean demo2@docte )

14:49:16 196.95. subject 2
0005Ws-04 91.196.95.33 ]
MXsSrv2.spamg : :

2014-10-29 ) mail2.comodo. : outgoing Accepted
1XjUYF- John john@doctean demo@docte _

14:43:43 91.196.95.33 subject
0002Dc-AU '

1 i1 [1-272] Perpage (15 |w
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The 'Download' button allows users to download the log report of sent mails for the filters entered and/or selected.
«  Click the Download button.
The download dialog will be displayed.

F B
Opening cutgeing.docteamcasg.comodo.od.valogs.zip u

You have chosen to open:

g outgoing.docteamcasg.comodo.od.ua.logs.zip
which iz WinRAR ZIP archive
from: . B -

What should Firefox do with this file?

) Openwith | WinRAR.ZIP (default) -

i@ : Save File

[] Do this automatically for files like this from now on.

OK ] ’ Cancel

You can choose to open the file by using the browse option or save the file in your system. The compressed log file will be saved
in the folder that you have configured for saving download files. The values in the log report will be separated by commas and
this file can be opened with appropriate application such as Excel or Openoffice Calc for easy analysis.

Sorting the Entries

Clicking any column heading switches the sorting of the entries based on the ascending/descending order of the entries as per
the information displayed in the respective column.

3.2.3 User Account Management

The 'Account Management' configuration area of the dashboard allows the users to change their login password, whitelist
settings and manage the subscription for periodical Quarantine summary report.

Note: You can access the 'Change settings' and 'Manage report subscriptions' screens only if these are enabled for your email
account by your administrator. If these are enabled, then 'Change settings' section in My Profile sub tab and 'Manage report
subscriptions sub tab will be available in the left hand side navigation area under the 'Account management' tab.
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3 Account management Change password

Ky prafme Mew passwaord |
) 38 repol [sF1w
Manage reporl Subsc ConMm passwond
Change settings
Whitelast my email : [7]

Save

Click the following links for more details:
«  Managing login password and whitelist settings

- Managing subscription for periodical summary reports

3.2.3.1 Managing Login Password and Whitelist settings

The 'My Profile' interface accessible from the ‘Account management' tab in the left hand side navigation allows a user to change
his/her login password and the whitelist status. All filtering checks in CASG are disabled for whitelisted recipients.

«  Click the 'Account management' tab on the left hand side navigation to expand and then click the "My profile' sub tab.

; coOMODO r_mmmm.
g Antispam Gateway

&) Incoming

My pr
@ Qutgoing

E Account management Chan

| Ny profile

Manage report subscriptions

The 'My profile' interface will be displayed.
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My profile € Heip

Change password

Mew passward .

Confirm password

Change settings

Whitelist my email - 7]

Note: The 'Change settings' section will be available in the 'My profile" interface only if the feature is enabled for you by your
administrator.

To change the user's password

« Inthe 'Change password' section, enter the new password and confirm it in the respective boxes and click the 'Save'
button.

Password successfully changed dialog will be displayed.

Success

@ FPassword was successfully saved.

«  Click 'OK".
Now you can access CASG using the new password.
To add or remove from Recipient Whitelist

» Inthe 'Change settings' section, select or deselect the "Whitelist my email' checkbox to add or remove yourself from
the Recipient Whitelist.

Settings successfully changed dialog will be displayed.
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Success

@ Settings successfully saved

«  Click 'OK".

3.2.3.2 Managing User's Subscription for Periodical Summary Reports

The 'Manage report subscriptions' interface accessible from the 'Account management' tab in the left hand side navigation

allows a user to configure subscription for periodical Quarantine summary reports. Refer to CASG Reports - an Overview for
more detalils.

Note: The administrator of your email account should have enabled this feature for you. If this is enabled, the 'Manage report
subscriptions' sub tab will be available in the left hand side navigation area under the 'Account management' tab.

To configure report subscription for the user

«  Click the 'Account management' tab on the left hand side navigation to expand and then click the 'Manage report
subscriptions' sub tab.
cCoMODO
' Antispam Gateway

(3 Incoming Mai

(L Cutgoing

E Account management

The 'Manage report subscriptions' interface will be displayed.
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Manage report subscriptions Help

Quarantine report

Hour Day of month Day of week Send empty Enabled Start date (GMT) Report length
@ Every day @ Every week day
©choose ©iChoose
0 |~ |« |~
y 1 (L (o MNext report for 1
’ E [ Oct 30,2014 04:00  day(s) from last run
B 2 (2014-10-29 04:00)
3

Feset settings to default

- If you want to receive the periodical Quarantine summary reports, ensure that the 'Enabled' check box is selected.
»  Leave the 'Send empty' checkbox unchecked if empty reports are not to be sent to recipients.
«  Select the frequency of the report to be sent to you from the 'Hour', 'Day of month' or 'Day of week' columns.

»  Hour - The reports will be generated and sent at the selected hour of the day or date chosen from 'Day of month'
or 'Day of week' columns.

- Day of month - The reports will be generated and sent every day or on the specific day every month chosen at
the hour selected from the 'Hour' column.

- Day of week - The reports will be generated and sent every day or on the specific day every week chosen at the
hour selected from the "Hour' column.

- Start date - Displays the start date of the report generation depending on the options chosen (as per Greenwich
Mean Time (GMT)).

«  Report length - Displays the period of the report that will be generated depending on the options chosen.

»  Click 'Save' for your settings to take effect.

»  Click 'Reset settings to default' button to configure default report generation period. The report will be generated every
24 hours starting from last report generated time or from 00:00 hours.

4 CASG Reports - An Overview

Comodo Antispam Gateway can periodically generate quarantine reports that are sent to the users. The reports will be sent
routinely at the times selected by the user.

« By default, reports are disabled for new users. Reports can be enabled or disabled for a user in Account
management > Manage Report Subscriptions.

The Quarantine Report contains a statistical breakdown of the mails that were identified as spam or containing malicious content
and were moved to Quarantine automatically by CASG, with the details on sender, receiver, date and attachments. Clicking the
subject line in the list will open the respective mail in a new CASG window.

The report can be subscribed to be received daily, weekly or monthly at the selected hour.
- Daily -The reports will be generated and sent daily to the user through email.

«  Weekly - The reports will be generated and sent to the user through email on every seventh day from the start date
set in the 'Start date’ field. The report will contain details of the mails quarantined during the past seven days. The first
report will be sent on the start date and will contain the statistics for the remaining days of the week from the day of
configuration and subsequently every seven days.
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«  Monthly - The reports will be generated and sent to the user through email on every 30th day from the start date set in
the 'Start date' field. The report will contain details of the mails quarantined during the past 30 days. The first report will
be sent on the start date and will contain the statistics for the remaining days of the month from the day of
configuration and subsequently every 30 days.

An example of a Quarantine summary report is shown below:

rg Quarantine Report for demol@docteamcasg.comodo.od.ua - Mazilla Thunderbird Lo | &)

Eile Edt View Go Message Tools Help
& GetMail ~ # Wite B cChat B AddressBook | @ Tag ~ =

From admin@csgga.comodo.od.ua’ 4 Reply| 4 Reply All| ~ | = Forward
|

fubject Quarantine Report for demol@docteamcasg.comodo.od.ua 4/22/2014 9:30 AM |

. |
To demol@docteamcasg.comodo.od.ua Other Actions = |

j @ COMODO

- Antispam Gateway

L Here is the quarantine report for demol@docteamcasg.comodo.od.ua from Apr 21, 2014 04:00 to
Apr 22, 2014 04:00

Subject From [ To Date Size | fl
o HE John Smith demol@docteamcasg.comodo.od.ua, N e
SRR e <fiatliena@gmail.com>= demo2@docteamcasg.comodo.od.ua LD MB L
| Allergies St < o 2014 i

For help, see the User guide: hiip:fhelp comodo comippic-157-1-294-3 398 Introduction-to-Comodg-Antispam-Gateway, himi

Having Trouble ? Support iz here to help. Open a Ticket at hitps:/isupport.comodo.com or call 1.5688.COMODO (266.6361)

«  Clicking on the 'Subject' link will open the respective mail in a new CASG window. You need to login to CASG to read
the mail in the new window.
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Appendix - CASG Comparison Table

There are two versions of CASG, a paid version will all features and a free version with limited features. The table given below
provides the details of features available for both the versions.

Features Paid Version Free Version

Number of domains and incoming / outgoing users Depends on the subscription |5 users and 1 domain

Number of domain aliases 5 Nil

Active Directory / LDAP Synchronization $

Create / Modify User Groups %

Assign permissions to User Groups

x

ol NN X

=

Number of user aliases per user

Incoming / Outgoing email filtering

View all quarantined emails

Release quarantined emails

Whitelist / Blacklist quarantined emails

Configure spam detection settings

Report spam emails

View queued emails in Delivery Queue

LEINENENEA YA YA NEN

Force Retry (Force Deliver) selected or all queued emails in
Delivery Queue

Create local recipients

Clear incoming / outgoing email cache

Log search incoming emails

Log search outgoing emails

Create domain aliases

Configure domain settings

Configure email size restrictions

Configure 'Blocked extensions' settings

View users' release requests

View users' whitelist / blacklist requests

Whitelist / Blacklist recipients

Whitelist / Blacklist senders

View users' login history

AN NN N NN NN N NN AN Y NN NN NE VA NN

| %8| \|% ¥ & % & % & % | % |&

Email archive
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Number of email administrator accounts Unlimited 1

Report management v £%
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About Comodo

The Comodo companies are leading global providers of Security, Identity and Trust Assurance services on the Internet. Comodo
CA offers a comprehensive array of PKI Digital Certificates and Management Services, Identity and Content Authentication
(Two-Factor - Multi-Factor) software, and Network Vulnerability Scanning and PCI compliance solutions. In addition, with over
10,000,000 installations of its threat prevention products, Comodo Security Solutions maintains an extensive suite of endpoint
security software and services for businesses and consumers.

Continual innovation, a core competence in PKI and a commitment to reversing the growth of Internet-crime distinguish the
Comodo companies as vital players in the Internet's ongoing development. Comodo, with offices in the US, UK, China, India,
Romania and the Ukraine, secures and authenticates the online transactions and communications for over 200,000 business
customers and millions of consumers, providing the intelligent security, authentication and assurance services necessary for
trust in on-line transactions.

Comodo Security Solutions, Inc.

1255 Broad Street
Clifton, NJ, 07013
United States

Tel: +1.888.256.2608
Tel: +1.703.637.9361

Email: EnterpriseSolutions@Comodo.com

For additional information on Comodo - visit http:/lwww.comodo.com.
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